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About This Guide 

Purpose 
This guide describes the operation and application of DCTools Configuration Software. 
 

 

Audience 
This guide is intended for use by dc power system engineers and installers familiar with: 
• the operation and configuration of Eaton dc power systems 
• general operating principles of dc power systems for telecommunications 
• the Microsoft® Windows® operating system environment. 
 

 

Reporting Problems with this Guide 
Please use this email address to report any problems you find in this guide: 
 
Eaton DC Product Marketing Communications 
EMAIL: DCMarketingNZ@eaton.com 
 

 

For Further Information and Technical Assistance 
For further information and technical assistance see Worldwide Support on page 117. 
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Related Information 
 

Title Device IPN 

Data-Voice-Video Power Solutions Installation Guide 
(24V North America Models) 

SM65 997-00012-76 

Whisper Single-Bay Outdoor Cabinet (with APS6-300 
Series) Installation Guide 

SC100 or SC200 997-00012-73 

Core Power Solutions Installation Guide (UL-Listed 
Models) 

SC200 997-00012-71 

Access Power Solutions Installation Guide (SM45 
versions) - Spanish 

SM45 997-00012-70 

Access Power Solutions Installation Guide (SM40 
versions) - Spanish 

SM40 997-00012-69 

Whisper Single-Bay Outdoor Cabinet Installation 
Guide 

SC100 or SC200 997-00012-67 

Data Power Solutions Quick Start Guide SM45 997-00012-66 

Enterprise Power Solutions Installation Guide (EPS) - 
Spanish 

SC100 or SC200 997-00012-64 

SC100 System Controller Handbook SC100 997-00012-63 

RM3-400/410/420 Series DC Power Systems SC100 or SC200 997-00012-62 

SC200 System Controller Handbook - Spanish SC200 997-00012-61 

Access Power Solutions Installation and Operation 
Guide (APS6-300/500 and APS12-300 Series) - Spanish 

SC100 or SC200 997-00012-60 

Access Power Solutions Installation Guide (APS3-300 
Series) - Spanish 

SC100 or SC200 997-00012-58 

SM65 Supervisory Module Handbook (Version 6)
  

SM65 v6 997-00012-55 

Data-Voice-Video 3G Power Solutions Installation 
Guide 

SC100 or SC200 997-00012-54 

SC200 System Controller Handbook SC200 997-00012-50 

Access Power Solutions Installation and Operation 
Guide (APS6-300/500 and APS12-300 Series) 

SC100 or SC200 997-00012-49 

Access Power Solutions Installation Guide 
(APS3-300 Series) 

SC100 or SC200 997-00012-48 

NPS24-014/015 DC Power Systems SM65 997-00012-47 

Data-Voice-Video Power Solutions Installation Guide 
(APR-3G Rectifiers) 

SM60 or SM65 997-00012-46 

Data-Voice-Video Power Solutions Installation Guide 
(UL-Listed Models) 

SM65 997-00012-44 

Access Power Solutions Installation Guide 
(SM40/APR48-03) 

SM40 997-00012-43 
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Title Device IPN 

Data-Voice-Video Power Solutions Installation Guide SM60 or SM65 997-00012-42 

Data Power Solutions Installation Guide SM45 997-00012-41 

Access Power Solutions Installation Guide (SM45 
versions) 

SM45 997-00012-38 

Access Power Solutions Installation Guide (SM40 
versions) 

SM40 997-00012-37 

SM65 Supervisory Module Handbook SM65 997-00012-35 

Network Power Solutions Installation Guide SM60 or SM65 997-00012-33 

Intergy Access Power System Installation Guide SM40 997-00012-29 

SM60 Supervisory Module Handbook SM60 997-00012-27 

Intergy Network Energy Source Installation Guide NSM35 997-00012-26 

CellSure Installation Guide CBC 997-00012-20 

SiteSure Installation and Configuration Guide - 997-00012-19 

Intergy SM50 Users Guide SM50 997-00012-09 

Intergy Mini Power System Installation Guide SM20 or SM30 995-00001-43 
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About DCTools 
DCTools is Microsoft® Windows® based software for control and management of Eaton's dc 
power systems. DCTools allows the viewing, editing, and back-up of configuration file data. 
A communications connection from a PC running DCTools to a dc power system is controlled 
by the Connection Manager (see About Connection Manager on page 6). Connection Manager 
maintains a list of communication connections and activates the connections as required.  
The types of communications connection depend on the dc power system model and 
configuration. Refer to the dc power system Installation Guide for information (see Related 
Information on page ii). 
DCTools runs under Microsoft Windows 2000, XP, Vista or Windows 7. 
 

 

Starting DCTools 
When you start DCTools the DCTools icon  appears in the System Tray at the right of the 
taskbar. 
When you start DCTools  for the first time  a Welcome screen is also displayed. 

 
 

 

► To close the welcome window 
1 If you do not want the Welcome screen to appear on subsequent startups, select Do not 

display this welcome screen again. 

 To make the Welcome screen reappear change the "Welcome Screen" setting in the DCTools 
config file (DCTools.cfg) located in the DCTools program folder. 

2 Click Close. 
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► To run DCTools 
• USB communications (SC200 only): 

Plug a USB cable from the PC to the USB port of the SC200 system controller. DCTools will 
start automatically. 

 The first time the SC200 USB connection is used, a warning about Windows Logo testing 
may be displayed. If this warning appears, select 'Continue Anyway'. 

• All other communication methods, either: 

• Right-click the DCTools icon  and choose: 
 

 Connection Manager to go to the Connection Manager window. 

 See About Connection Manager on page 6. 

 Help to view this Help guide. 

 About to view DCTools version and copyright information.  

 Shut down DCTools to close all DCTools windows and remove the System 
Tray icon. 

 

• Or, double-click the DCTools icon  in the System Tray to go straight to the Connection 
Manager window. 

 See About Connection Manager on page 6. 
 

 

Shutting Down DCTools 
When you shut down DCTools: 
• all DCTools Data windows are closed: 

• all active connections are terminated 
• all logged data is purged. 

• the DCTools icon  is removed from the System tray (at the right of the taskbar), and ... 
• the DCTools program terminates. 

 If you want to terminate an active connection without totally shutting down DCTools, close all 
Data windows for that Device. Or, in Connection Manager, de-activate the connection (this leaves 
the Device's Data windows open in Offline mode). 

 
 

► To shut down DCTools completely 
• Right-click the DCTools System Tray icon  and select Shut down DCTools. 

 If you shut down DCTools while a connection is active, and later restart DCTools, the Data 
window for the relevant Device will be automatically opened as soon as that Device responds (the 
Connection Manager window is not automatically opened). 
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About Connection Manager 
 Connection Manager is not used for USB communications. See Starting DCTools on page 2. 

Connection Manager enables you to: 
• Set up and maintain one or more connections to Eaton dc power systems and CellSure 

Battery Controllers (CBC). 

 Refer to the dc power system Installation Guide for information (see Related Information on 
page ii). 

• Configure general communications options that apply to all connections (except USB). 
• Activate a connection. When the relevant Device responds, the main DCTools Data window 

is opened, displaying the details for that Device. 
• Terminate an active connection (you can also do this by closing the Data window for the 

relevant Device). 
 

 

Opening Connection Manager 
► To open the Connection Manager window 
• Right-click the DCTools System Tray icon  and select Connection Manager. 

 -or- 

• Double-click the DCTools System Tray icon . 
 
Notes: 
• You can only have one Connection Manager window open. If you try to open Connection 

Manager when it is already open, you will go to the existing Connection Manager window. 
• If you close the Connection Manager window when a connection is active there is no effect 

- that connection remains active. If the connected Device is responding, the Data window 
shows its latest values. If a Device has not yet responded after its connection has been 
activated, polling of that Device continues. 

• If you close DCTools while a connection is active, and later restart DCTools, you will 
automatically go to the Data window for the relevant Device when it responds - 
Connection Manager is not opened. 

 
 

About the Connection Manager window 
The Connection Manager window lists potential and active connections, and has the following 
elements. 
• Menus 

• Global menu on page 7 
• Connection menu on page 7 
• Help menu on page 8 
• Right-click menu on page 8 

• Toolbar on page 9 
• Connection List on page 9 
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Global menu 
 

Menu item Function Keyboard Equivalents 

Properties Opens the Global Communication 
Options dialog 

F9 
Right-click menu/Properties 
(except on connection name) 

Close Closes the Connection Manager 
window (does not terminate active 
connections) 

ALT-F4 

 
 

Connection menu 
 

Menu item Function Equivalents 

Open Opens the Data window for the 
selected active connection 
(disabled for inactive 
connections) 

Right-click menu/Open 
Double-click active connection name in list 

Enabled Activates or deactivates the 
selected connection 

Space bar 
Check box in list 
Right-click menu/Enabled 

New Adds a new connection to the 
list and opens the Comms 
Properties dialog for that 
connection 

INSERT key 

 button 
Right-click menu/New 

Delete Deletes the selected connection 
from the list 

DELETE key 

 button 
Right-click menu/Delete 

Rename Enables editing of the selected 
connection name 

F2 key 
Right-click menu/Rename 
Edit in Properties dialog 

Properties Opens the Comms Properties 
dialog for the selected 
connection 

ENTER key 

 button 
Double-click inactive connection name in 
list 
Right-click menu/Properties 
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Help menu 
 

Menu item Function Equivalents 

Help Opens this help at the first topic F1 key 

Language Displays  a list from which you 
can select another language. See 
Display Accessibility Options on 
page 23. 

 

About 
DCTools 

Displays an About window, 
giving version and copyright 
details 

 

 
 

Right-click Menu 
All right-click menu items have the same functions as in the Connection menu (except for 
Properties – see below). Available menu items vary, depending on where you right-click, as 
shown below. 
 

Menu item Available when you right-click... 

New Anywhere in the list except a connection name 

Properties Anywhere in the list – however: 
• On Connection name, opens Comms Properties dialog for that 
connection  
• Elsewhere, opens Global Communication Options dialog 

[Others] A connection name only  

 
 



Connection Manager 
 

 
Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
9

 

Toolbar 
 

Button Function Equivalents 

 Adds a new connection to the list and 
opens the Comms Properties dialog for 
that connection 

 If an existing connection is 
highlighted then the new connection 
will be a copy of the existing 
connection. 

INSERT key 
Connection menu/New 
Right-click menu/New 

 Deletes the selected connection from the 
list  

DELETE key 
Connection menu/Delete 
Right-click menu/Delete 

 Opens the Comms Properties dialog for 
the selected connection 

ENTER key 
Double-click inactive connection name 
in list 
Right-click menu/Properties 

 
 

Connection List 

Name 
Shows the connection's given name – right-click and select Rename to change. The check box at 
the left indicates whether the connection is inactive or active, and can be used to change this 
status:  

 Inactive – click to activate 
 Active – click to de-activate 

For an active connection, an icon between the check box and name indicates communications 
status: 

 Trying to establish communications 
 Communications established  
 Unable to establish communications 

 

Comms Properties 
This read-only text summarizes the communications properties for the connection. Use the 
Comms Properties dialog to view and edit all communications properties 

 

Status 
 

Idle Connection inactive. 

Connecting... Trying to establish communications. 

Connected Connection active and communications established (Device type and ID 
shown). 

Failed Unable to establish communications within a preset time (a new attempt 
will be made) – details of the communications problem are also shown. 
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Setting Global Communications Options 
Global Communications options apply to all connections. 

► To view and possibly change Global Communications options 
1 Press F9 or, in the Global menu, select Properties.  

The Communications Options dialog is then displayed. 
 

2 On the Protocol tab, edit the following values where required. 
 

S3P options: SNMP options: 

Number of Retries1 Number of Retries2 

Timeout3 Timeout4 

Overriding Timeout5  

 
 

                                                           
1 The number of consecutive, unsuccessful connection attempts to any Device, after which Connection Manager will 
display a Failed status for that connection (if the Overriding Timeout has not expired first). Accept the default  value of 1 if 
the connections are very reliable. Otherwise, select a higher Number of Retries. 
2 The number of consecutive unsuccessful connection attempts to a Device, after which Connection Manager will 
displaying a Failed status for that connection. Ethernet: Adjust this Timeout value if large network delays are common. 
Otherwise, use the default of 20s. Modem connections: Because of the buffering that occurs, this needs to be more than 
for direct connections. A minimum value of 60s is recommended. 
3 The time Connection Manager will wait for a response from a Device before displaying a Failed status for that 
connection.S3P Multidrop Networks: You may need to adjust this Timeout value if large network delays are common. 
Otherwise, use the default of 1000ms. Modem connections: Because of the buffering that occurs, this needs to be more 
than for direct connections. A minimum value of 2000ms is recommended. 
4 The maximum time Connection Manager will spend trying to connect to a Device before displaying a Failed status for 
that connection. Ethernet: Adjust this Timeout value if large network delays are common. Otherwise, use the default of 
20s. Modem connections: Because of the buffering that occurs, this needs to be more than for direct connections. A 
minimum value of 60s is recommended. 
5 The maximum time Connection Manager will spend trying to connect to a Device before displaying a Failed status for 
that connection (if the Number of Retries have not occurred first).S3P Multidrop Networks: Accept the default value of 
60s.Modem connections: Because modem communications are slower than other types of communications, the 
overriding timeout should be more than for direct connections. A value of 120s is recommended. 
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3 On the Modem tab, edit the following values where required. 
 

Modem options: Modem Security options: 

Number of Dial Attempts6 Scripting Timeout7 

Retry Wait8 Pause After Script Complete9 

S3P Connect Sequence Retries10  

Idle Auto-Disconnect Timeout11  

 
 

4 Click OK to apply your changes and close the dialog (or click Cancel to ignore any changes 
and close the dialog. 

If you made any changes, they will apply to any active connections from now on. 
 

 

Maintaining a Connection List 
Use Connection Manager to maintain your list of all potential and active DCTools connections, 
with their individual communications properties.  
This section covers the following topics: 
• Setting Up a New Connection on page 12 
• Renaming a Connection on page 12 
• Setting Connection Properties on page 13 
• Deleting a Connection from the List on page 20 
• Activating a Connection on page 17 
• Terminating an Active Connection on page 19 

 

                                                           
6 (Applies only to networks using modem connections.) The maximum number of unsuccessful re-dial attempts 
Connection Manager will make to a Device via a modem, before displaying a Failed status for that connection. 
Connection Manager will not re-dial until the Retry Wait time has expired. 
7 (Applies only to modem connections with callback security.) The maximum time Connection Manager will wait for an 
expected prompt when running a Modem Logon script, before giving up and reporting a Script Failed communications 
error. 
8 (Applies only to modem connections.) The time Connection Manager will wait before making a re-dial attempt to a 
Device via a modem. The Number of Dial Attempts value determines how many times Connection Manager will re-dial 
the same Supervisory Module or CellSure Battery Controller. 
9 (Applies only to modem connections with callback security.) The maximum time Connection Manager will wait for the 
remote modem to begin sending data after scripting is complete. If no data is received in this time, Connection Manager 
will display a Failed status for that connection. This setting depends on the modems you use. A value between 5000ms 
and 8000ms is usually appropriate. Smaller values may speed communications, but setting this time too short may make 
modem communications unreliable. ... 
10 (Applies only to modem connections with the S3P protocol.) After a carrier has been detected, the modem may still 
require some time before the connect response comes through. The Number of Connect Retries should be set to at 
least5. There is little harm in setting it too high, but setting it too low can reduce your communications reliability. 
11 (Applies only to modem connections.) This value has little effect unless one modem is being shared (or calls are 
charged per minute). In the case of the shared modem, this value should be set as short as possible to maximize the 
availability of the modem for callback. 
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Setting Up a New Connection 
► To add a new connection to the list 
1 Do one of the following.  

Click the  toolbar button.  
-or-  
Select New from the Connection menu. 
-or-  
Press Insert. 
 If an existing connection is highlighted then the new connection will be a copy of the existing 

connection. 
2 A new connection with the default name *no name* or * Copy of xxxxx is then listed, and 

the Comms Properties dialog is displayed. 
3 In the Comms Properties dialog, edit the properties as necessary for that connection, and 

click OK. 
For more details, see Setting Connection Properties on page 13. 
 

 With a new Device, you should consider whether you want to set up a password to provide some 
protection against unauthorized changes to configuration parameter values for that Device. For 
more details, see Write Access Password Protection Option on page 32. 

 
 

Renaming a Connection 
► To rename a connection 
1 Do one of the following.  

• Right-click the connection in the list, and select Rename from the popup menu. 
 -or- 

• Select the connection in the list, and select Rename from the Connection menu. 
 -or- 

• Select the connection in the list, and press F2. 
2 The connection name then becomes an editable field.   
3 Edit the name as required for that connection. 
4 Press Enter (or click outside the field) when you have finished editing. 

 You can also change a connection name on the Comms Properties dialog. See Setting Connection 
Properties on page 13. 
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Setting Connection Properties 
Use the Comms Properties dialog to view and possibly change the name and communications 
properties of a DCTools connection. 

► To access the Comms Properties dialog for a connection 

• Select the connection name and click  (or press Enter or select Properties from the 
Connection menu. 

 -or- 
• Right-click the connection name and select Properties from the popup menu. 

 The Comms Properties dialog is also displayed automatically when you are Setting Up a New 
Connection on page 12. 

Required communications properties for each type of connection are listed below. 
 

► To specify Comms Properties for different types of connection 
1 On the Comms Properties dialog, specify options depending on the type of connection (you 

must set Comms Enabled to False before you can change most options). 
2 Use the following table to reference typical settings for that connection type. 
 

Standalone Device connection Using SM45/SM50/SM65* Passthrough (CBC only) 

S3P over direct RS232/422/485 on 
page 13 

S3P Passthrough direct on page 15 

S3P over dialup modem on page 14  S3P Passthrough over dialup modem on page 15 

S3P Multidrop on page 14 S3P Passthrough Multidrop on page 16 

S3P over Ethernet (TCP/IP) on page 
14 

S3P Passthrough over Ethernet (TCP/IP) on page 16 

 
3 If you want to activate this connection now, set Comms Enabled to True. Otherwise, set it to 

False. 
4 Click OK to confirm your changes and close the Properties dialog. 

–or– 
Click Apply to confirm your changes and leave the Properties dialog open. 
–or– 
Click Cancel to reject any unconfirmed changes and close the Properties dialog. 

 

 * The SC200's Serial Server function makes the SC200's RS232 port available to any software via 
Ethernet. For example, use Serial Server to connect DCTools to a CellSure Battery Controller 
(CBC) connected to the SC200. For information refer to the SC200 System Controller Handbook 
(see Related Information on page ii). 

 
 

Standalone Device Connection 

S3P over direct RS232/422/485 
 

Protocol S3P 

Connect Using COMn (where n = 1, 2, ...) 

S3P Address 0 (broadcast) 
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S3P over dialup modem 
 

Protocol S3P 

Connect Using [Name of installed modem] 

More button [Use to set modem connection properties] 

S3P Address 0 (broadcast) 

Phone Number [Phone number of the remote modem] 

 
See also: S3P dialup modem - through SM45/SM50/SM65 on page 15. 

 

S3P Multidrop 
 

Protocol S3P 

Connect Using COMn (where n = 1, 2, ...) 

More button Not available 

S3P Address 1 through 65279 (individual address) 

 
See also: S3P Multidrop - through SM45/SM50/SM65 on page 16. 

 

S3P over Ethernet (TCP/IP) 
 Available with SM45/SM65/SC200, or other devices with an RS232/Ethernet interface.  

 

Protocol S3P 

Connect Using Local Network 

S3P Address 0 (Broadcast) 
1 - 65279 (individual address) 

Server IP Address User-specific - allocated by network administrator 

Server Port Default is 14000 for SM45/SM65/SC200 (may need to be changed - 
confirm with network administrator) 

Telnet Default is unselected. Leave unselected for SM45/SM65/SC200 or 
SGM10. 
Select this check box if the server will process the Telnet IAC 
(Interpret as Command) character as a Telnet command, and 
DCTools needs to escape those characters. 
 
Select this check box if using an external Ethernet server or router 
and there is a communications problem. 
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Passthrough Communications (CBC via SM45/SM50/SM65 only) 

S3P Passthrough direct - SM45/SM50/SM65 
 For CellSure Battery Controller with SM45/SM50/SM65 Passthrough only. 

 

Protocol S3PPassthrough  

Connect Using COM1 or COM2 

S3P Address Format is s:c: 
• For SM50: 

s = SM50's S3P address 
c = CBC's S3P address 
(in both cases, 0 = Broadcast, 1 through 65279 = individual 
address) 

• For SM45 or SM65: 
s = SM45/SM65's S3P address 
c = CBC's RCP slave address (150, 151, ...) 

 

S3P Passthrough over dialup modem - SM45/SM50/SM65 
 CellSure Battery Controller with SM45/SM50/SM65 Passthrough only. 

 

Protocol S3PPassthrough 

Connect Using [Name of installed modem] 

More button [Use to set modem connection properties] 

S3P Address Format is s:c: 
• For SM50: 

s = SM50's S3P address 
c = CBC's S3P address 
(in both cases, 0 = Broadcast, 1 through 65279 = individual 
address) 

• For SM45 or SM65: 
s = SM45/SM65's S3P address 
c = CBC's RCP slave address (150, 151, ...) 

Phone Number [Phone number of the remote modem] 
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S3P Passthrough Multidrop - SM45/SM50/SM65 
 CellSure Battery Controller with SM45/SM50/SM65 Passthrough only. 

 

Protocol S3PPassthrough 

Connect Using COMn (where n = 1, 2, ...) 

More button Not available 

S3P Address Format is s:c: 
• For SM50: 

s = SM50's S3P address 
c = CBC's S3P address 
(in both cases, 0 = Broadcast, 1 through 65279 = individual 
address) 

• For SM45 or SM65: 
s = SM45/SM65's S3P address 
c = CBC's RCP slave address (150, 151, ...) 

 

S3P Passthrough over Ethernet - SM45/SM50/SM65 
 CellSure Battery Controller with SM45/SM50/SM65 Passthrough only*. SM50 will require an 

RS232/Ethernet interface. 
 

Protocol S3PPassthrough 

Connect Using Local Network 

S3P Address Format is s:c, where: 
s = S3P address of SM45/SM50/SM65 
c = CBC's S3P address 
(in both cases, 0 = Broadcast, 1 through 65279 = individual address) 

Server IP Address User-specific - allocated by network administrator 

Server Port Default is 14000 for SM45/SM65 (may need to be changed - confirm 
with network administrator) 

Telnet Server-specific: 
Default is unselected. Leave unselected for SM45/SM65/SC200 or 
SGM10. 
Select this check box if the server will process the Telnet IAC 
(Interpret as Command) character as a Telnet command, and 
DCTools needs to escape those characters. 
 
Select this check box if using an external Ethernet server or router 
and there is a communications problem. 

 * The SC200's Serial Server function makes the SC200's RS232 port available to any software via 
Ethernet. For example, use Serial Server to connect DCTools to a CellSure Battery Controller 
(CBC) connected to the SC200. For information refer to the SC200 System Controller Handbook 
(see Related Information on page ii). 
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Activating a Connection 
 The connection must be inactive – check box is cleared . 

► To activate a connection 
• Click the connection's check box to select it ( ). 
 -or- 
• Right-click the connection in the list and select Enabled from the popup menu. 
 -or- 
• Select the connection in the list and select Enabled in the Connection menu. 
 -or- 
• Select the connection in the list and press the spacebar. 
 

 

The check box shows a checkmark  and Connection Manager tries to communicate with the 
target Device, using the properties defined for that connection.  
An icon appears by the connection name, and the Status column for the connection indicate the 
communications status: 

Icon Status column Meaning 

 Connecting...  Trying to establish communications. 

 Failed -  Connection 
Error 

Unable to establish communications within a preset 
time (a new attempt will be made) – details of the 
communications problem are also shown (see Possible 
Problems on page 18). 

 Connected Communications established (Device type and serial 
number shown). 

 
 

When a Device responds, Connection Manager will try to discover the type and interface version 
of that Device. If these are supported by this version of DCTools, then a Data window for that 
Device is opened. If not, a message dialog will be displayed informing you of this.  
If no Device responds, Connection Manager will continue ‘listening’ on this connection. 
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Possible Problems 
► You get no response when a new or changed connection is activated (Target Failed 

to Respond or other error message) 
• Check the connection properties.  
• Check your PC cables and connectors. 
• Check that the target Device is powered and running, and is physically connected to the 

communications link.  
• If you are using a network link, check the present network status (for example, try 

accessing other Devices on the network, or contact the network administrator). 
• Check that the target Device's communications settings are correctly configured and S3P 

Access is Enabled. 
• Try resetting the Device. 
• If you are using Passthrough to connect to a CellSure Battery Controller (CBC), try 

activating a connection to that SM45/SM50/SM65 itself. If that works, check that the CBC 
has the correctly configured address and that it is connected to the SM45/SM50/SM65. 

 

► A Device that previously responded does not when its connection is reactivated  
• Check that the Device is powered and running, and is physically connected to the 

communications link.  
• If you are using a network link, check the present network status (for example, try 

accessing other Devices on the network, or contact the network administrator). 
• Check that the Device's communications settings have not been reconfigured (for example, 

the protocol or address have changed). 
• Check that S3P Access is Enabled on the target Device. 
• Try resetting the Device. 

 If no Devices are responding, check your PC cables and connectors. In some cases, may need to 
restart your PC. 

 

► Two or more Devices respond on the same active connection  
The Devices are able to use the same communications link, but have the same configured 
address, protocol type, and so on. Ensure that only one Device will respond by either 
disconnecting unwanted Devices, or by configuring each Device with a unique address. 

 

► An unsupported Device responds 
If a Device responds, but its type and interface version are not supported by this version of 
DCTools, then a message dialog will be displayed informing you of this. 
Upgrade to the latest the version of DCTools available from 
www.powerquality.eaton.com/downloads. 

 

► ‘Port Already Open’ error with direct connection 
This can be caused by another application that is running and tying up the COM port, or by 
another application not closing the COM port properly. You can test this by trying to open the 
COM port, using a terminal program such as Hyperterminal. If Hyperterminal can open the 
COM port without trouble, then try again with DCTools. 
Confirm that no modem is set up to use that COM port within DCTools.  

 

► CRC errors on a S3P/Ethernet connection 
The usual cause for CRC errors over an Ethernet link is whether or not the remote socket server 
is performing Telnet command processing on the data stream coming into the socket. See 
following for more details. 
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► Telnet Command Processing 
 

Default is unselected. Leave unselected for SM45/SM65/SC200 or SGM10. 
Select this check box if the server will process the Telnet IAC (Interpret as Command) character as a Telnet co
DCTools needs to escape those characters. 
 
Select this check box if using an external Ethernet server or router and there is a communications problem. 

 
 

Terminating an Active Connection 
 The connection must be active (check box is selected ). 

► To terminate an active connection and close its Data window 
 Logged data collected for all Devices is purged from the system when you close all DCTools Data 

windows. 
• Close the Data window for the connection. 

 

► To terminate an active connection (without closing its Data window) 
• In the Connection Manager window, do one of the following. 

• Click the connection's check box to clear it ( ). 
 -or- 

• Right-click the connection in the list and unselect Enabled in the popup menu. 
 -or- 

• Select the connection in the list and unselect Enabled in the Connection menu. 
 -or- 

• Select the connection in the list and press the spacebar. 
 -or- 

• In the Comms Properties dialog for that connection, set Comms Enabled to False and 
click OK. 

 
See also: Shutting down DCTools on page 3. 
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Deleting a Connection from the List 
► To delete a connection from the list 
1 If the connection is active ( ), deactivate it by clicking the connection's check box to clear it 

( ). 
2 Do one of the following: 

• Select the connection in the list, and click . 
 -or-  

• Right-click the connection in the list, and select Delete from the popup menu. 
 -or-  

• Select the connection in the list, and select Delete from the Connection menu. 
 -or-  

• Select the connection in the list, and press Delete. 
3 A confirmation dialog then displays. 

 If the connection is still active, a message dialog informs you of this instead. terminate the 
active connection (see details on page 19) then delete the connection from the list (as above). 

4 Click OK to confirm the deletion. 
5 The connection is then removed from the list. 
 

 

Closing Connection Manager 
Closing the Connection Manager window does not shut down Connection Manager – it continues 
functioning, any open DCTools Data windows remain open, and a new DCTools Data window 
may be opened when communications is established with an active connection that had not 
previously responded (that is, no Data window had already been opened for that connection).  
However,  shutting down DCTools (see details on page 3) exits all DCTools windows and 
executables, and purges all logged data. 
See also: About the DCTools Log window on page 34. 
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Opening and Closing DCTools windows 

Opening a New Data window 
The first DCTools Data window for a  Device opens automatically when you activate a new 
connection. 
You can then open additional Data windows for a connected Device – for example, so you can 
simultaneously view more than one type of data for that Device. 

 

► To activate a new Device (and open a Data window for it) 
1 Open Connection Manager, using one of the following methods. 

• Right-click the DCTools System Tray icon  and select Connection Manager. 
 -or- 
• If the Connection Manager window is already open, go to it (for example, by clicking 

ALT-TAB). 
2 In Connection Manager, activate the relevant connection, by clicking its check box to select 

it ( ) or by selecting the connection in the list and pressing the spacebar. 
3 When the Device responds, a Data window for that Device is opened. 

 

► To open another window for the same Device 
• In the File menu, select New Window. 
 

 

Closing a Data window 
If you have only one open DCTools window for a Device, closing that window deactivates the 
connection for that Device. 

Closing all Data windows does not shut down DCTools. The DCTools icon  remains in the 
System Tray and Connection Manager continues functioning (whether or not its window is 
open). 
A new Data window may be opened automatically when communication is established for 
active connections that had not previously responded (that is, where no Data window had yet 
been opened for that connection). 

 Closing all Data windows purges all collected DCTools log data. 
See also: About the DCTools Log window on page 34. 
 

 

Opening and Closing the DCTools Log window 
 The DCTools Log window applies to all active connections. You can open only one DCTools Log 

window at time. 

► To open the DCTools Log window 
• In the File menu of any Data window, select Open DCTools Log. 

 -or- 

• In the status bar of any Data window, if the DCTools Log indicator  is showing, click it. 

 This icon shows in the Status bar when at least one warning or error event currently applies 
for the connected Device (the Number next to the icon is the number of these). 
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► To close the DCTools Log window 
• Click the  button (top right of the window). 

• Right-click the  button (top left of the window) and select Close. 
 

 

Online v Offline Mode 
You can run DCTools in the normal Online mode (when the connected Device is communicating 
with DCTools), or you can change to Offline mode (when communications are suspended). 
Offline mode enables you to make several changes without actually sending any of them to the 
connected Device until you are ready. This is similar to holding changes, except that no data is 
being received from the Device. 
 

 

► To change from Online to Offline mode 
1 Open Connection Manager, using one of the following methods. 

• Right-click the DCTools System Tray icon  and select Connection Manager. 
 -or- 

• Click the connection button  in the Status bar. 
 -or- 
• If the Connection Manager window is already open, go to it (for example, by clicking 

ALT-TAB). 
2 In Connection Manager, de-activate the relevant connection, by clicking its check box to 

clear it ( ) or by selecting the connection in the list and pressing the spacebar. 
3  When the Device responds: 

• The word Offline shows in the title bar and Status bar of all open Data windows for that 
Device. 

• The connection button in the Status bar changes to . 
 

 

► To revert to Online mode 
1 In Connection Manager, activate the relevant connection, by clicking its check box to select 

it ( ) or by selecting the connection in the list and pressing the spacebar. 
2  When the Device responds: 

• The word Offline is removed from the title bar of all open Data windows for that 
Device. 

• The word Offline is replaced by Online in the Status bar of all open Data windows for 
that Device. 

• The connection button in the Status bar changes to . 
 

 

Display Accessibility Options 
► To toggle full-screen display mode 
Either. 
• In the View menu, select: Full Screen. 

 –or– 
• Press F11. 

 –or– 
• Click  in the toolbar. 
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► To change the display font size 
• In the view menu, select Fonts and then select a font size from the submenu. 

 

► To change the display language 
• In Connection Manager select: Help > Language. 

 If Connection manager is not open then see Opening Connection Manager on page 6. 
• Select the required language from the list. Click Ok. 
• Shutdown then restart DCTools to change the display to the new language. See Shutting 

Down DCTools on page 3. 
 

 If the language is changed to "English (United States)" then all temperatures will be shown in 
degrees Fahrenheit (°F) instead of Celsius (°C). 

 
 

About the Data window 

Title bar 
The title bar of a Data window shows: 
• The name of the connected Device 
• The word Offline when connection to the Device is currently offline. 
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Data Window Menus 

File Menu 
 

Menu item Function Equivalents 

New Window Opens another Data window for the Device CTRL + N 

Open 
DCTools Log 

Opens the DCTools Log window  

DCTools 
Restore 

Loads data into a specific DCTools window from a .dct 
file. 

 To create a .dct file: right-click anywhere in the window 
and select DCTools Backup ...  (see details on page 30). 

 

ICE Backup / 
Restore 

Saves (.dcc format) or restores (.irc, .dcc or .dcs format) 
all data from a Configuration file. 

 File formats: 
.dcc - configuration file format used in latest products 
(does not include site specific information). 
.dcs - "snapshot" configuration file format used in 
latest products (includes site specific settings including 
Site Identity, IP Address and S3P Address). Create a 
.dcs file via a web browser connected to the device (some 
devices only). 
.irc -  configuration file format used in older products 
(does not include site specific information). 

 A Restore cannot be performed if Pending Changes 
exist. 

 

Close Closes the Data window (terminates connection if only 
window for the Device) 

ALT + F4 

 
 

Edit Menu 
 

Menu item Function Equivalents 

Copy Copies data from the relevant view(s) to the clipboard. Copy in right-
click menu 

Paste Pastes previously copied data from the clipboard back 
into the relevant view(s). 

Paste in right-
click menu 

Hold Changes Toggles whether changes are held or sent immediately to 
the connected Device. 

CTRL + H 

 
Apply 
Changes 

Sends held changes to the connected Device. CTRL + A 
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Go Menu 
 

Menu item Function Equivalents 

Back Goes back in the display sequence. ALT + ← 

 
Forward Goes forward in the display sequence. ALT + → 

 
Home Displays the Summary (home) window.  
 

 

View Menu 
 

Menu item Function Equivalents 

Full Screen Toggles full-screen display mode F11 

 
Toolbars Displays a submenu of toolbar display options.  

Status Bar Toggles display of the Status bar.  

Information 
Bar 

Displays a submenu of Information Bar display options.  

Fonts Displays a submenu of display fonts (Smallest to 
Largest). 

 

 
 

Help Menu 
 

Menu item Function Equivalents 

DCTools Help  Opens this help guide. F1 

Current Form 
Help 

Opens DCTools Help at the topic related to the function 
currently displayed (if available). 

 

Web links Links to various web pages related to Eaton and Eaton 
dc products. 

 

About 
DCTools 

Displays an About window with version and copyright 
details. 
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Toolbar (Data window) 
 The Data window toolbar is displayed when Standard Buttons is selected (View > Toolbars). 

 
 

Button Function Equivalents 

 Go to the previous view. 
Click  to select from a list of previous views. 

ALT + ← 

 Return to a view (only available after you have gone 
back to a previous view). 
Click  to select from a list of views to return to. 

ALT + → 

 Go to the topmost (home) view. HOME 

 Toggle Hold changes (do not send changes to the 
connected device, or send immediately). 

 

 Apply changes (send any pending changes to the 
connected device). 

 

 Toggle full-screen display. F11 

 
 

► To show or hide text labels for toolbar buttons 
• In the View menu, select Toolbars, then select Text Labels from the submenu. 
• When text labels are selected, The toolbar looks like this: 

 
 

 

Information Bar 
The optional Information bar is displayed at the left of the Data window. 
It may display either of the following. 

Available Forms Tree view 
• Shows the structure of Data browser views for the connected Device. 
• Highlights the currently displayed Data browser view. 
• Enables you to quickly select a Data browser view. 

Pending Changes list 
• Shows changes you have made in DCTools that have not yet been sent to (or confirmed by) 

the connected Device. 
• Will accumulate changes made when you are in Hold Changes mode (until you manually 

apply them by clicking  or selecting Apply Changes in the Edit menu). 
• Is automatically cleared when the changes are acknowledged by the connected Device 

(either when you are not in Hold Changes mode or after you manually apply them). 
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► To display the Available Forms Tree view 
• In the View menu, select Information Bar, then select Form Tree in the submenu. 

-or- 
•  Press F9. 
 

 

► To display the Pending Changes list 
• In the View menu, select Information Bar, then select Pending Changes in the submenu. 
 

 

► To hide the Information bar display 
• Click the  button in the header of the Information bar. 

-or- 
• In the View menu, select Information Bar, then select None in the submenu. 
 

 

Data Browser view 
The Data browser view is the main data display area.  
 

 

Button Functions 
 

Button Function 

 Click to view more table columns. 

 Click to hide table columns. 

 Click to view more table rows. 

 Click to hide table rows. 

 Click to show a list of options. 

+ Click to show or hide a panel or table. 
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Data Editing 
 

 
For a list box, either edit the field directly, or click  and 
select a new value from the list. 

 
Black text 

Indicates a data value that can be changed. 

 
Gray text 

Indicates a data value that has been changed, but not 
validated by DCTools. 

 Press the Enter (Return) key on the keyboard for 
DCTools validation of new value. 

 
Green text 

Indicates a data value that has been changed and 
validated by DCTools, but the connected Device has not 
been updated (pending change). 

 Click the Apply Changes button to update the 
connected Device. 

 
Red text 

A change that has failed validation by DCTools. Enter a 
correct value. 
Hold the mouse pointer over the field (or look in the 
Pending Changes view) to see details of the validation 
error.  

 
Gray 

background 

Indicates a data value that cannot be changed. 

 
 

► To change a data value 
• Double-click or click and drag to select the text. 
• Type a new value. 
• Press the Enter (Return) key on the keyboard. 
 

 

Each change is immediately validated by DCTools: 
• If the change fails validation an error message is displayed with details of the validation 

error. 
• If the change passes validation and you are in Online mode: 

• If Hold Changes is selected, no changes are sent until you select Apply Changes. 
• Otherwise, each change is sent immediately to the connected Device. 
• After a change is sent to and accepted by the connected Device and the change is 

recorded in the DCTools Log. 
• If a change is not accepted by the connected Device, an error dialog is displayed. 
• If the communications link fails, the change remains pending until a subsequent 

download succeeds. 
• If the change passes validation by DCTools and you are in Offline mode, the change 

remains pending until you revert to Online mode. 
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Data Specific Help 
Hold the mouse pointer over any data item to show specific help text. 
 

 

Right-click Menus 
Right-click in a data window to select part or all (depending on where you right-click) of the 
data. The right-click menu then shows three options for the selected data.  
 

Menu item Function Equivalents 

Copy Copy the selected data to the clipboard.  

Export ... Export the selected data to a plain or comma-delimited 
(.csv) text file. 

Edit > Copy 

DCTools 
Backup ... 

Save all or selected data to a DCTools Backup file (.dct). 

 To restore the selected data go to File > DCTools 
Restore ... (see details on page 25). 

 

 
 

Status bar 
The Data window's optional Status bar has three panels. 

Connection button / indication 
 

  Online Connected to the connected Device and uploading information 

  Online Connected to the connected Device and downloading information 

  Offline Not communicating at present 

 Click this button to open the Connection Manager window. 
 

 

DCTools Log indicator/button 
 

 One or more Critical/Major/Urgent alarms or error events currently apply for 
the connected Device (the number is indicated). 

 No Urgent events apply, but one or more Minor/Non-urgent alarms or error 
events apply for the connected Device (the number is indicated). 

 No Urgent or Non-urgent events apply, but one or more Warnings or 
informational events apply for the connected Device (the number is indicated). 

 Click this button to open the DCTools Log window. 

 
 

Message Panel 
This is used to display brief information about the currently selected display item. 
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► To toggle display of the Status bar 
• In the View menu, select Status bar. 
 

 

Navigation 
Use the following standard methods to navigate to another DCTools view (or window). 
 

Using the Information Bar's tree view 
Select an item in the tree view to display the Data browser view for that item. 

 If the Tree view is not displayed, select Information Bar in the View menu, then select Form Tree. 
 

Using the Go menu 

► To go to the previous view 
• In the Go menu, select Back. 

► To return to a view 
• In the Go menu, select Forward. 

 Only available after you have gone back to a previous view. 
 

Using Hotlinks 
The header of each Data view contains hotlinks to related displays. Click a hotlink to go to that 
view. 

 

Using Toolbar buttons 
 If the toolbar is not displayed, select Toolbars in the View menu, then select Standard Buttons in 

the submenu. 

► To go to the previous view 
• Click  or click the adjacent  button to select from a list of previous views. 

► To return to a view 
• Click  or click the adjacent  button to select from a list of views you can return to. 

 Only available after you have gone Back to a previous view. 
 

Using keyboard shortcuts 
 

ALT + ← Go to the previous view. 

ALT + → Return to a view. 

 Only available after you have gone back to a previous view. 

↓ Go down to the next item in the tree view. 

↑ Go up to the next item in the tree view. 

→ Open a closed tree branch, or go to the first child item of an open branch. 

← Close an open tree branch, or go to the parent item of a branch. 

HOME Go to the top of the tree view. 

END Go to the last item in the tree view. 
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Using Multiple windows 

► To go to another DCTools window 
• Use the standard Windows operations – for example, press ALT + TAB, or select the 

window in the Windows taskbar. 

 You will have multiple Data windows open when there is more than one connected Device. 
You may also open additional Data windows for each connected Device. 

 
 

Write Access Password Protection Option 
In DCTools, you can set a Write Access Password for each connected Device. 
When a Write Access Password is set a Log On dialog will be displayed for them to enter the 
password for that Device. If they do not correctly enter the password, any changes will be 
ignored. 

 This does not apply to SM50s, which have their own Access Level protection. 
 

 

► To set a password for a Device 
1 Go to the Communications. 
2 Type a password in the Write Access Password field. Press the Enter (Return) key on the 

keyboard. 
3 Click Apply Changes to update the connected Device. 

 The password will apply for the next DCTools session. 

 A password only has to be entered once per session. 
 

 

► To change or clear a password 
1 Go to the Communications. 
2 Type a new password in the Write Access Password field (or delete and leave blank for no 

password). Press the Enter (Return) key on the keyboard.  
3 Click Apply Changes to update the connected Device. 
 

 

Backing Up and Restoring Configuration Files 
All Configuration details (except site specific details) from the connected device can be saved 
into a DCC file (SC100/SC200 controllers) or an IRC file (all other devices). This file can be 
restored to either the same connected device, or to another of the same type and version, via 
DCTools. 
This enables you to: 
• Keep a record of a device's configuration file. 
• Restore a device's configuration file back to one backed up earlier. 
• Upgrade a device's configuration file to a newer one (for example, one obtained from your 

Eaton dc power system supplier). 
• Transfer identical configuration files (except for site specific data) to a number of devices. 

 When backing up a configuration file, you always create a new specially formatted file with the 
.dcc or .irc suffix. 

 For information on other files types see Data Window Menus on page 25. 
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► To back up and restore the configuration file for the connected device 
Go to File > ICE Backup/Restore. For more information see Data Window Menus on page 25. 
 

 

Copying and Pasting Data 
You can copy particular Data Browser view data to the clipboard, and then paste this data into 
the same DCTools view – for either the same connected Device, or another (usually of the same 
type). 
This enables you to: 
• Restore changed data values for a Device back to previously copied values. 
• Copy specific saved data values to other Devices. 
• Transfer data to other applications (for example, Notepad). 

 The clipboard can hold only one set of copied data.  
 

 To back up all Configuration details from the connected Device into an IRC file, and later restore 
these from backup, see Backing Up and Restoring Configuration Files on page 32. 

When copying data, the data copied to the clipboard depends on the type of displayed view 
and, in some cases, where you right-click: 
 

In this view...  If you right-click...  This data is copied... 

A 'parent' view listing its 
subsidiary, 'child' views 

 Anywhere in the view or its 
header 

 All present data from 
all the child views 

A view with displayed 
data in one display area 

 Anywhere in the view or its 
header 

 All data in that view 

A view with displayed 
data in multiple areas 

 In the view's header or 
outside all its display area 
boundaries 

 All data in that view 

A view with displayed 
data in multiple areas 

 Inside a display area 
boundary 

 Data in that area only 

 
 

► To copy all data displayed by or under a DCTools view 
1 Go to the relevant view (see table above). 
2 Right-click in the view header and select Copy from the popup menu. 
 

 

► To paste only the data in one display area of a DCTools view 
1 Go to the relevant view. 
2 Right-click in the relevant display area and select Paste from the popup menu. 
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► To paste values previously copied to the clipboard 
1 Go to the relevant view. 
2 Right-click and select Paste from the popup menu. 
 
When you paste data from the clipboard: 
• If Paste is not valid for that view, it will not be available in the menu. 
• Changes are treated as if you made them by editing. For more details, see . 
• Your present view does not change (even if the restored data applies to another view). 
• Your present view does not change (even if the restored data applies to another view). 
• If any settings are incompatible (for example, when you copy across different types of 

Device), an error dialog is displayed, and those values are not copied. 
 

 

About the DCTools Log window 
 To open the DCTools Log window click on the Information icon . See Opening and Closing the 

DCTools Log window on page 22. 
The DCTools Log window is for  diagnostic purposes. It lists 'global' events recorded by 
DCTools. These include status and error messages related to each active connection (but not 
events recorded by the connected Devices themselves). 

 The DCTools Log window applies to all active connections. You can open only one DCTools Log 
window at time. 

DCTools Logs: 
• Have a maximum number of entries. After this limit is reached, the oldest entries are then 

deleted. 
• Do not include log entries for events recorded by connected Devices (these are shown in 

the relevant Data window Log views for the specific Devices). 
• Can be viewed for Devices no longer connected (up until all DCTools Data windows are 

closed). 
 

The tree view lists all DCTools Logs. 
• The topmost (Root) DCTools Log lists information about global events that are not specific 

to any connected Device (for example, Application Started). 
• Under the Root, DCTools Logs are listed for each connected Device and, in some cases, for 

related subsystems (for example, an NES has an NSM35 log and one per battery tray). Each 
of these logs lists communications status messages, system item changes, and other events 
specific the Device or subsystem. 

• Select an DCTools Log in the tree view to display the relevant log entries in the Event table 
at the right. 

 



Using DCTools 
 

 
Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
35

 

This table lists entries in the selected DCTools Log. 
• Each entry has an associated priority, indicated by one of the following icons. 
 

 Information 
only 

Logged for informational purposes only; does not indicate 
any abnormalities 

 Warning Non-critical for the originating process 
For example, an S3P Invalid data id comms error warning is 
non-critical because communications can continue with 
next item. 
If unexpected warnings continue to occur during normal 
operation, contact your Eaton dc power system supplier. 

 Error Usually critical for the originating process and results in 
process termination 
For example, an Invalid database state error is critical 
because the target database state is undetermined after 
that point and communications cannot continue, so the 
connection will be de-activated. 
Such errors should not occur during normal operation – if 
they do, contact your Eaton dc power system supplier. 

 
• Each entry is time-stamped (to the nearest second) and has an identifier (ID). 
• Each entry has a Count value that is incremented each time a new event with the same ID 

occurs. 
• You can change the listing sequence by using the toolbar buttons (see Toolbar below). 

 

Toolbar 

 Empties the log 

 Lists log entries by time of occurrence 

 Lists log entries by priority, then time of occurrence 

 Lists log entries by ID 
 

 Multiple entries with the same ID are not shown when you sort on ID (but are in the other listing 
sequences). 

                   
See also:  Opening and Closing the DCTools Log window on page 22. 
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Shutting Down DCTools 
When you shut down DCTools: 
• all DCTools Data windows are closed: 

• all active connections are terminated 
• all logged data is purged. 

• the DCTools icon  is removed from the System tray (at the right of the taskbar), and ... 
• the DCTools program terminates. 

 If you want to terminate an active connection without totally shutting down DCTools, close all 
Data windows for that Device. Or, in Connection Manager, de-activate the connection (this leaves 
the Device's Data windows open in Offline mode). 

 
 

► To shut down DCTools completely 
• Right-click the DCTools System Tray icon  and select Shut down DCTools. 

 If you shut down DCTools while a connection is active, and later restart DCTools, the Data 
window for the relevant Device will be automatically opened as soon as that Device responds (the 
Connection Manager window is not automatically opened). 

 
 



Using DCTools 
 

 
Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
37

 





 

Chapter 4

System Functions
  
  

 

 
Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
39

 

C h a p t e r  4  
System Functions 

Overview 

Topic Page 

System Summary 40 

Configuration 41 

Alarms 47 

Analog Inputs 50 

Digital Inputs 50 

Digital Outputs 51 

Control Processes 52 

Rectifiers 59 

Batteries 59 

Controller Log 60 

PC Log 62 

 
 
  



DCTools Help 
 

40 Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
 

 

  
 

System Summary 

 
 

 

The System Summary view includes: 
• A single-line diagram of the dc power system controlled by the connected Device. This 

diagram shows: 
• AC input voltage 
• dc output voltage 
• Rectifier current 
• Battery current 
• Load current 
• Battery temperature 

 ? indicates no information has been received from the connected Device. 
N/A indicates values that do not currently apply. 
O/R indicates values that are outside their full normal operating range. 

• A list of active voltage control processes. 

 Click on "Voltage Control Summary" to go to the Voltage Control Summary view (see details 
on page 52). 

• A list of active alarms 

 Click on "Alarms" to go to the Alarms View (see details on page 47). 
• A list of hyperlinks to other views. 
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Configuration 

Identity 

 
The System Identity view shows the following groups of values from the connected Device. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 

 
 

Item Group Description 

Identity Details specific to the connected Device. 

 The system and site specific information is not included in 
DCC or IRC format configuration files. See Data Window 
Menus on page 25. 
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Communications 

 
The Communications view shows the following groups of values from the connected Device 
(not all options are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on + to expand a panel. 
 

 



System Functions 
 

 
Copyright © 2001-2010 Eaton Corporation.  All Rights Reserved. 

E    May 2010 
43

 

 

Item Group* Description 

Front Panel Operation of  the LCD screen and keypad of the connected 
Device. For more information refer to the device handbook. 

Serial Settings for serial communications with the connected Device. 
Includes port settings, modem option settings including 
PowerManager Callback and SMS Notifications. 

Ethernet Settings for Ethernet communications with the connected 
Device. 

S3P Set S3P access, address and password 

HTTP (Web) Settings to enable web access and setup registered users. 

SNMP Settings to allow communication with third-party Network 
Management System (NMS) software using SNMP. 

Serial Server Settings to make an SC200's RS232 port available as an 
Ethernet port. 

Modbus Settings to allow communication with third-party Building 
Management System (BMS) software using Modbus-TCP. 

CSP These are parameters for specific protocols. Contact Eaton for 
further details. 

 If these protocols are not used then leave the parameters at 
their default values. 

 * Some items are not available with all Devices. 
 

 

RXP (SC100/SC200 only) 

 
The RXP Devices view shows the rectifiers and I/O boards connected (registered) to the 
SC100/SC200 via the RXP communications bus,  and the I/O board mappings for the SC200. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on  to expand a table. 
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Item Group Description 

RXP Devices Details of the rectifiers, I/O board or other RXP Devices. 

I/O Board to Serial 
Number Mapping 
(SC200 only) 

Maps an I/O board number (Num) to the serial number of 
each connected I/O board. 

 

 SC200 LVD mappings are made in the LVD view. See Low Voltage Disconnect on page 57. 
 

 

Identify Device (SC200 only) 
In DCTools, RXP devices (rectifiers and input/output boards) are referenced by their serial 
numbers. 

► To identify an RXP device corresponding to a particular serial number 
• In the RXP Devices table, select Identify Device. 
• Either: 

• The Power-on LED on the selected I/O board or SiteSure-3G module will flash for 60 
seconds, or 

• All LEDs on the selected rectifier will flash for 60 seconds. 
 

 

Standby Mode 
Two SC100 or SC200 system controllers can be connected together via RXP. One will be active 
and control the dc power system, and the other will be in Standby Mode (on, but inactive). 
If the active SC100 or SC200 fails or is disconnected, then the SC100 or SC200 in Standby Mode 
will become active (after a short delay). 
 

 

Time 

 
The Time view shows the following groups of values from the connected Device (not all options 
are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on + to expand a panel. 
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Item Group Description 

Time Synchronization Shows the current time and date, and allows synchronization 
of the date and time on the connected Device with the PC 
(some devices only). 

SNTP Settings to allow time synchronization with SNTP time 
servers. 

 
 

External I/O (SM40/SM45/SM50/SM60/SM65 only) 

 
The External I/O view shows the connected I/O devices. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on + to expand a panel and  to expand a table. 

 Some items are not available with all Devices. 
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Item Group Description 

IO Module Comms 
Configuration 

SM40/SM45/SM60/SM65 only: The table lists any connected 
SiteSure I/O devices. If more than one SS-GP or more than 
one IOM-CS master module is connected then edit the number 
in the Change module number to: column to set sequential 
master module addresses. 

 Master modules are pre-loaded with default addresses (SS-GP 
= 1, IOM-CS = 2). 

Refer to the SiteSure Installation and Configuration Guide for 
more details (see Related Information on page ii). 

AC Metering Comms 
Configuration 

SM45/SM65 only: Configure the communications for the 
external ac metering option. 

CellSure Battery 
Controller (CBC) 

SM45/SM50/SM65 only: Check the box if one or more 
CellSure Battery Controllers (CBC) are connected. 

 The CBC Functions cannot be  edited unless this box is 
checked. See details on page 64. 

Refer to the CellSure Installation Guide for more details (see 
Related Information on page ii). 
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Alarms 

 
The Alarms view shows the following groups of values from the connected Device (not all 
options are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on + to expand a panel and  and  to expand a table. 

 Some items are not available with all Devices. 
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Item Group Description 

Summary Alarms Indicates if one or more alarms of each severity is active. 

Alarm States Indicates the state and allows configuration of each alarm. 

Reset Battery Test Failed 
Alarm 

This command attempts to reset Battery Test Failed alarm. 

Reset Rectifier Comms 
Lost Alarm 

This command attempts to reset Rectifier Comms Lost alarm 
and Multiple Rect Comms Lost alarm. 

Alarm Configuration Set the following alarm values: 
• Enable Audible Alarm Indication 
• Alarm Recognition Period 
• AC Fail 
• Low Float 
• High Load 
• Low Load 
• Battery Temperature 
• System Overload 

 For information on how to configure Alarms refer to the controller handbook or dc power system 
installation and operation guide. See Related Information on page ii. 

 
 

Smart Alarms (SC200 only) 

 
 
 
The Smart Alarms view shows the following groups of values from the connected SC200. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on + to expand a panel and  and  to expand a table. 
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Item Group Description 

Smart Alarms Configure Smart Alarms. 

Alarm Sources Set any of these as inputs to Smart Alarms: 
System Alarms, Analog Input alarms, Digital Input 
alarms, or other Smart Alarms. 

Schedule Sources Set time schedules as inputs to Smart Alarms. 

System Value Sources Set any of these as inputs to Smart Alarms: 
Bus Voltage, Rectifier Current, Load Current, Battery 
Current, Battery Temperature, Load Power, System 
Power, Ah Discharged, Number Of Rectifiers Failed, or 
Number Of Rectifiers Comms Lost. 

 For information on how to configure Smart Alarms refer to the SC200 System Controller 
handbook. See Related Information on page ii. 

 

Smart Alarms are a software simulation of logic gates to allow the logical combination of other 
alarms, time schedules and/or system values. Up to 32 Smart Alarms can be configured. 
A single Smart Alarm is the equivalent of a multi-input AND, OR or XOR logic gate. More 
complex logic arrangements are created by using one Smart Alarm as an input into another. For 
example: 
 
 

Two input AND gate: 
SAx = Sa AND Sb 
  

Three input OR gate: 
SAy = Sa OR Sb OR Sc 

 
Multi-gate logic: 
SAz = SAx OR NOT Sd 
 

 One input is Smart Alarm SAx (output 
from another gate). The other input is 
negated. This is available with Alarm 
Sources only. 

 

Key: 
SAx, SAy, SAz are Smart Alarms (entered in the Smart Alarms table). 
Sa, Sb, Sc, Sd are the Sources (entered in the Alarm Sources, Schedule Sources or System Value 
Sources tables). 
  
Smart Alarms also have optional activation and deactivation delays. When activated they can 
cause alarm indications (unless Severity is set to Control) and can activate one or two digital 
outputs (in the same way as other alarms). 

 For more information and application examples contact your Eaton DC product supplier and 
request Eaton Application Note AN0106, SC200 Version 3 Advanced Alarm Features. 
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Analog Inputs 

 
The Analogs view shows the values of the analog inputs to the connected Device (not all 
options are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on  and  to expand a table. 

 Some items are not available with all Devices. 
 

 
 

Item Group Description 

System Values The dc power system measurements from the connected 
Device. 

Analog Inputs Indicates the value and allows configuration of any analog 
inputs. 

 For information on how to configure Analog Inputs refer to the controller handbook or dc power 
system installation and operation guide. See Related Information on page ii. 

 
 

Digital Inputs 
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The Digitals view shows the values of the digital inputs to the connected Device (not all options 
are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on  and  to expand a table. 

 Some items are not available with all Devices. 
 

 
 

Item Group Description 

System States The dc power system states from the connected Device. 

Digital Inputs Indicates the value and allows configuration of any digital 
inputs. 

 For information on how to configure Digital Inputs refer to the controller handbook or dc power 
system installation and operation guide. See Related Information on page ii. 

 
 

Digital Outputs 

 
The Digital Outputs view shows the state of the digital outputs (relays) controlled by the 
connected Device (not all options are available with all devices). 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• Click on  and  to expand a table. 

 Some items are not available with all Devices. 
 

 
 

Item Group Description 

Digital Outputs Indicates the state and allows configuration of digital outputs. 

 For information on how to configure Digital Outputs refer to the controller handbook or dc power 
system installation and operation guide. See Related Information on page ii. 
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Control Processes 
See: 
Voltage Control on page 52 
Active Voltage Control on page 53 
Temperature Compensation on page 53 
Equalize on page 54 
Fast Charge on page 54 
Battery Current Limit on page 55 
Battery Test on page 55 
Battery Characterization on page 56 
LVD (Low Voltage Disconnect) on page 57 
Generator Control on page 58 
 

 

Voltage Control 
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The Voltage Control summary view shows a diagram of the rectifier voltage control processes 
controlled by the connected Device. 

 ? indicates no information has been received from the connected Device. 
N/A indicates values that do not currently apply. 
O/R indicates values that are outside their full normal operating range. 

• To view information on each value hold the mouse pointer over the value to show the 
specific help text. 

• The Float Voltage can be edited in this view. 

 See Data Editing on page 29. 
• Click on the name of a control process to go to the relevant view. See: 

Active Voltage Control on page 53 
Temperature Compensation on page 53 
Equalize on page 54 
Fast Charge on page 54 
Battery Current Limit on page 55 
Battery Test on page 55 

 
 

Active Voltage Control 

 
The Active Voltage Control (AVC) view shows the state of AVC and allows it to be enabled and 
disabled. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Active Voltage Control on page 87. 
 

 

Temperature Compensation 
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The Temperature Compensation view shows the state of the process, allows it to be enabled and 
disabled, and allows the parameters to be set. 

 For some devices, Upper Limit and Lower Limit are fixed. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Temperature Compensation on page 94. 
 

 

Equalize 

 
The Equalize view shows the state of the process, allows it to be enabled and disabled, started 
and stopped, and allows the parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Equalize on page 90. 
 

 

Fast Charge 
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The Fast Charge view shows the state of the process, allows it to be enabled and disabled, 
started and stopped, and allows the parameters to be set. Not all parameters are available with 
all devices. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Fast Charge on page 90. 
 

 

Battery Current Limit 

 
The Battery Current Limit view shows the state of the process, allows it to be enabled and 
disabled, and allows the parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Battery Current Limit on page 88. 
 

 

Battery Test 
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The Battery Test view shows the state of the process, allows it to be enabled and disabled, 
started and stopped, and allows the parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• To clear a Battery Test Fail alarm, click on the Reset Battery Test Fail button. 
See also: Battery Test on page 89. 
 

 

Battery Characterization 

 
The Battery Characterization view (SC100 only) shows the state of the process, allows it to be 
started and stopped, and allows the parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• To clear a Battery Characterization Fail alarm, click on the Reset Battery Characterization Fail 

button. 
 

 For the SC200, Battery Characterization is part of the Battery Time Remaining view. See Batteries 
on page 59. 

 
See also: Battery Time Remaining on page 89. 
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LVD (Low Voltage Disconnect) 
Typical LVD screen for SC200 system controllers. 
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Typical LVD screen for other system controllers. 

 
 

 

The Low Voltage Disconnect view shows the state of LVD channels, allows them to be enabled 
and disabled, and allows the parameters to be set (not all options are available with all devices). 

 An SC200 system controller can have up to 16 LVD contactors mapped to up to 16 LVD 
channels. Other system controllers have only two LVD channels. 

 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Low Voltage Disconnect on page 93. 
 

 

Generator Control 
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The Generator Control view shows the state of the process and allows the parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
 
See also: Generator Control on page 90,  Fast Charge on page 54 or Equalize on page 54. 
 

 

Rectifiers 

 
The Rectifiers view shows the operating conditions of all registered rectifiers and allows the 
rectifier parameters to be set. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
See also: Load-based Rectifier Shutdown on page 92 (not available with all devices). 

 Load Based Run Time is only displayed if Load Based Rectifier Shutdown is Enabled. 
 

 

Batteries 
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The Batteries view shows the battery conditions (not all are available with all devices) and 
allows configurable parameters such as Cells Per String and Capacity to be set. 
The Battery Current Sensor Fail Recognition Period (SC200 only) is an optional battery current 
sensor fail delay. Set if momentary battery current sensor fail conditions stop battery related 
control processes. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• To set the Ah Discharged back to zero and stop any active battery control processes, click on 

the Reset Battery State button. 

 Battery Time Remaining is only available with the SC200 or SC100 system controllers. See 
Battery Time Remaining on page 89. 

 Midpoint Battery Monitoring is only available with the SC200 system controller. See Battery 
Mid-point Monitoring on page 88. 

 
 

Controller Log 

Event Log 

 
The Event Log view shows the contents of the Event Log from the connected Device. 
• Click Save to File... to save the log in either plain text, comma separated text or Microsoft 

Access format. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
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Data Log 

 
The Data Log view shows the contents of the Data Log from the connected Device (not available 
with all devices). 
• Click Save to File... to save the log in either plain text, comma separated text or Microsoft 

Access format. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
 

 

Configuration 

 
The Log Configuration view shows allows the Event Log and Data Log parameters to be set. 

 Data Log is not available with all devices. 
• To edit an item see Data Editing on page 29. 
• To view information on each value hold the mouse pointer over the value to show the 

specific help text. 
• To delete all entries from all logs, click on Clear Logs. 
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PC Log 

 
The PC Log view allows data from the connected Device to be saved in a plain text or comma 
separated text file. 

• Click on  to select the file type and destination. 
• Slide or click the slide bar to set the interval between readings (5s - 60 minutes). 
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Summary View 
The CBC Summary view displays the following summary information for a CellSure Battery 
Controller. 

 The CellSure Battery Controller (CBC) check box (in the External I/O view) must be checked. See 
External I/O on page 45. 

Items are listed in display order, under each display area. Unless indicated these values cannot 
be changed. 

 If CBC modules are connected to and configured for an SM45/SM50/SM65, DCTools can also 
display the limited battery data sent by the CBC to the SM45/SM50/SM65, in the 
SM45/SM50/SM65 Battery Management System view. 

 

Values area 
These values apply over all battery strings. 
 

Date Time The present date and time, as indicated by the CBC real-time clock. 
(Editable) 

Number of Strings Number of configured battery strings (Editable). 

Blocs per String Number of battery blocs per string (Editable). 

Bloc Voltage Rated voltage of each battery bloc (Editable). 

Ambient 
Temperature 

Indicates the ambient temperature at the batteries, in degrees 
Celsius or Fahrenheit, as applicable. 
O/R (out of range) indicates that the temperature sensor is faulty or 
is not connected. 

Battery Reserve 
Time 

Estimated remaining time in minutes before the batteries fully 
discharge (N/A if not all battery strings are discharging). 

Battery Reserve 
Charge 

Remaining charge level in Ampere hours, averaged over trays (N/A 
if not all battery strings are discharging). 

Battery Precise 
Capacity 

Total available battery capacity in Ampere hours (measured from a 
full discharge). 

Battery Estimated 
Capacity 

Estimated total available battery capacity in Ampere hours (derived 
from a partial discharge) (Editable). 
 

Battery State of 
Health 

Present battery State of Health (SOH) value averaged over all 
configured strings. 
SOH values are calculated during partial discharge, and are the ratio 
of the actual charge (at a specific battery voltage) to the expected 
charge (based on the string characterization tables). 
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String Voltage graph displays 
These graphs display voltages for each battery bloc in the selected string. 
Click a String button to display the bloc voltages for that string. 
 

► To zoom in on an area within the graph 
1 In the graph, click and drag to the right to define the area to enlarge. 
2 Release the mouse button to view. 

 Click the  button to see instructions for zooming the graph display in and out. 
 

Alarms list 
Summary alarm indicators (either, both, or none): 
 

 indicates that one or more urgent alarms apply. 

  indicates that one or more non-urgent alarms apply. 

 
String alarm indicators: 
 

 indicates that one or more urgent alarms apply for that string. 

 indicates that no urgent alarms apply, but one or more non-urgent alarms 
apply. 
All blocs are shown, indicating blocs with and without alarms. 

 under the bloc number indicates a bloc with one or more alarms. 
 under the bloc number indicates no alarms for that bloc. 

 
 

Realtime Views 

CBC Realtime Values view 

Summary values 
These values apply over all battery strings. 

 The Editable column indicates values you can change. 
 

Battery Reserve 
Time 

Estimated remaining time in minutes before the batteries fully 
discharge (N/A if not all battery strings are discharging) (Non-
editable). 

Battery Reserve 
Charge 

Remaining charge level in Ampere hours, averaged over trays (N/A 
if not all battery strings are discharging) (Non-editable). 

Battery Precise 
Capacity 

Total battery capacity in Ampere hours (measured from a full 
discharge) (Editable). 

Battery Estimated 
Capacity 

Estimated total available battery capacity in Ampere hours (derived 
from a partial discharge) (Editable). 

Battery State of 
Health 

Present battery State of Health (SOH) value averaged over all 
configured strings (Editable). 
SOH values are calculated during partial discharge, and are the ratio 
of the actual charge (at a specific battery voltage) to the expected 
charge (based on the string characterization tables). 
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Field table 
These read-only True/False values apply during and following a full or partial battery 
discharge (including a Discharge Test) – that is, when all strings in the battery system are 
discharging. 
 

Discharge Running A True state indicates that the CBC has reported that batteries are 
discharging at present. 

Full Discharge 
Complete 

A True state indicates that a full discharge has completed. 

Full Discharge Test 
Pass 

A True state indicates that a full discharge test has successfully 
completed (met the configured Discharge Conditions). 

Partial Discharge 
Complete 

A True state indicates that a partial discharge has occurred (typically 
30 percent). 

Partial Discharge 
Test Pass 

A True state indicates that a partial discharge test has successfully 
completed (met the configured Discharge Conditions). 

 Discharge details for each string are also displayed (see below). 
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String tables 
The first of these two tables lists the following values for each string. 

 The Editable column indicates values you can change. 
 

String Calculated 
Voltage 

Total of bloc voltages for the string (non-editable). 

Bloc Average 
Voltage 

Average bloc voltage for the string (non-editable). 

Current String current (non-editable). 

Temperature String temperature in degrees Celsius or Fahrenheit, as applicable 
(non-editable). 
O/R (out of range) indicates that the temperature sensor is faulty or 
is not connected. 

AmpHours 
Discharged 

Total Ampere hours the string has discharged so far (zero if string is 
not actually discharging). (Non-editable) 

Average Reserve 
Charge 

Remaining charge level in Ampere hours, averaged over blocs in the 
string (N/A if batteries are not actually discharging). (Non-editable) 

Worst Reserve 
Charge 

Remaining charge level in Ampere hours, based on the worst (most 
discharged) bloc in the string (N/A if batteries are not actually 
discharging). (Non-editable) 

Average Reserve 
Time 

Estimated remaining time in minutes before the string blocs fully 
discharge, averaged over all blocs in the string (N/A if batteries are 
not actually discharging). (Non-editable) 

Worst Reserve Time Estimated remaining time in minutes before the first string bloc fully 
discharges (N/A if batteries are not actually discharging). (Non-
editable) 

Precise Capacity Total available string capacity in Ampere hours (measured from a 
full discharge). (Editable) 

Estimated Capacity Estimated total available string capacity in Ampere hours (derived 
from a partial discharge). (Editable) 

State of Health Present string State of Health (SOH) value (derived from a partial 
discharge). 
SOH values are calculated during partial discharge, and are the ratio 
of the actual charge (at a specific battery voltage) to the expected 
charge (based on the string characterization tables). (Editable) 
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The second table lists the following discharge information for each string. These read-only 
True/False values apply during and following a full or partial string discharge (including a 
Discharge Test). 
 

Running A True state indicates that the CBC has reported that battery string 
is discharging at present. 

Partial Complete A True state indicates that the string has completed a partial 
discharge test. 

Partial Valid A True state indicates that the string has successfully completed a 
partial discharge test (met configured Partial Discharge conditions). 

Full Complete A True state indicates that the string has completed a full discharge 
test. 

Full Valid A True state indicates that the string has successfully completed a 
full discharge test (met configured full Discharge conditions). 

Discharge 
Interrupted 

A True state indicates that a discharge test of the string has been 
interrupted before completion. 

Average Current 
Fail 

A True state indicates that the average string battery current during 
discharge has exceeded the specified tolerance. 

String Temp Fail Battery temperature has exceeded the specified tolerance. 

Recharge Too Short Recharge time prior to the discharge has not reached the specified 
minimum. 

 

String Voltage graph display 
This graph displays voltages for each battery bloc in the selected string. 
If more than one string applies, click another String button to display the bloc voltages for that 
string. 

Click  to enlarge the graph view. 
 

Bloc Voltage table 
Under the graph display, a table showing all bloc voltages for all strings is displayed. Each row 
lists the bloc voltages for that string, in millivolts. 
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CBC State of Health view 
The CBC State of Health view displays the following battery data, which is read or derived 
from the CellSure Battery Controller. Items are listed in display order, under each display area. 

Battery values 
These values apply over all battery strings. 
 

Battery Precise 
Capacity 

Total battery capacity in Ampere hours (measured from a full 
discharge). (Editable) 

Battery Estimated 
Capacity 

Estimated total available battery capacity in Ampere hours (derived 
from a partial discharge). (Editable) 

Battery State of 
Health 

Present battery State of Health (SOH) value averaged over all 
configured strings. (Editable) 

 SOH values are calculated during partial discharge, and are the 
ratio of the actual charge (at a specific battery voltage) to the 
expected charge (based on the string characterization tables). 

 

String table 
This table lists the following values for each string. 
 

String Calculated 
Voltage 

Total of bloc voltages for the string. (Non-editable) 

Bloc Average 
Voltage 

Average bloc voltage over the string. (Non-editable) 

Current String current. (Non-editable) 

Temperature String temperature in degrees Celsius or Fahrenheit, as applicable. 
(Non-editable) 
O/R (out of range) indicates that the temperature sensor is faulty or 
is not connected. 

AmpHours 
Discharged 

Total Ampere hours the string has discharged so far (zero if string is 
not actually discharging). (Non-editable) 

 
 

Average Reserve 
Charge 

Remaining charge level in Ampere hours, averaged over blocs in the 
string (N/A if batteries are not actually discharging). (Non-editable) 

Worst Reserve 
Charge 

Remaining charge level in Ampere hours, based on the worst (most 
discharged) bloc in the string (N/A if batteries are not actually 
discharging). (Non-editable) 

Average Reserve 
Time 

Estimated remaining time in minutes before the string fully 
discharges, averaged over all blocs in the string (N/A if batteries are 
not actually discharging). (Non-editable) 

Worst Reserve Time Estimated remaining time in minutes before the first bloc fully 
discharges (N/A if batteries are not actually discharging). (Non-
editable) 
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Precise Capacity Total available string capacity in Ampere hours (measured from a 
full discharge). (Editable) 

Estimated Capacity Estimated total available string capacity in Ampere hours (derived 
from a partial discharge). (Editable) 

State of Health Present string State of Health (SOH) value (derived from a partial 
discharge). (Editable) 

 SOH values are calculated during partial discharge, and are the 
ratio of the actual charge (at a specific battery voltage) to the 
expected charge (based on the string characterization tables). 

 

Bloc table 
This table lists the following values for each bloc. Each row represents one bloc, with its string 
and bloc numbers shown. You can change these values. 
 

Bloc Precise 
Capacity 

Total available bloc capacity in Ampere hours (measured from a full 
discharge). 

Bloc Estimated 
Capacity 

Estimated total available bloc capacity in Ampere hours (derived 
from a partial discharge). 

Bloc State of Health Present battery State of Health (SOH) value for the bloc (derived 
from a partial discharge). 

 SOH values are calculated during partial discharge, and are the 
ratio of the actual charge (at a specific battery voltage) to the 
expected charge (based on the string characterization tables). 

 
 

Configuration Views 

CBC Configuration View 
Use this display to view and possibly change the CellSure Battery Controller configuration. 
The CBC Configuration view displays the following parameter values. Items are listed in 
display order, under each display area. You can change any of these parameter values. 

 

Hardware Setup values 
These parameters apply to CBC hardware configuration. 
 

Value Description 

Operator Notes Optional text note for operators (up to 40 characters). 

Installer Notes Optional text note for installers(up to 40 characters). 

Bloc Type Optional text description of the bloc type(up to 20 characters). 

System Polarity The Earth polarity for the power system(Positive Earth or 
Negative Earth). 

Current Metering Enables or Disables Current Metering at the CBC. 

Current Shunt Scaling Current scaling factor for current shunt measurements input to 
the CBC. 
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Relay table 
This table indicates the present state and configured active state for the two CBC output relays. 
Each relay becomes active when an alarm of that type applies (Urgent or Non-Urgent). 
 

Value Description 

Relay Identifier for the relay (Urgent or Non Urgent). 

Relay State (Read-only) Indicates the present state of the relay at the CBC. 

 Urgent Relay activated 

 Non-urgent Relay activated 
- Relay not activated 

Active State Sets whether the relay is Energized or De-energized when it is 
activated. 

  

Battery Setup values 
These values apply over all battery strings. 
 

Value Description 

Number of Strings Number of configured battery strings. 

Blocs per String Number of battery blocs per string. 

Bloc Voltage Configured nominal voltage of each battery bloc. 
 

Discharge Conditions values 
These parameter values define battery discharge conditions at the CBC. 
 

Value Description 

Bloc End Voltage Bloc Voltage determining completion of a full discharge. 

Rated Bloc Capacity Manufacturer's rated capacity for a bloc. 

Discharge Rate Expected average current of any string during a discharge. 

Discharge Rate 
Tolerance 

Percentage allowed variation in string current during a 
discharge – if the average string current throughout the 
discharge exceeds this, a String Current Fail alarm activates. 

Discharge Temp Expected string temperature during a discharge. 
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Discharge Temp 
Tolerance 

Allowed variation in string temperature during a discharge – if 
string temperature exceeds Discharge Temp by more than this, 
a String Temperature Fail alarm activates. 

Partial Discharge Depth Percentage drop in charge required before a Partial Discharge 
is considered to have occurred. 

Minimum Recharge 
Time 

Time (in hours) the batteries must recharge before a valid 
discharge test can be performed. A Recharge Too Short alarm 
activates if this limit is not reached. 

Reserve Time Low 
Urgent threshold 

Reserve Time (in minutes) below which the Urgent Low 
Reserve Time alarm activates. 

Reserve Time Low 
NonUrgent threshold 

Reserve Time (in minutes) below which the Non-urgent Low 
Reserve Time alarm activates. 

 
 

CBC Communications view 
The CBC Communications view shows the following CBC parameter values related to both 
modem communications (to a PC) and slave communications (to the CBC's voltage 
measurement modules at the batteries). Items are listed in display order, under each display 
area. 

 

General values 
 You can change any of these values. Refer to the CellSure Installation Guide for configuration 

information (see Related Information on page ii). 
 
 

Value Description 

Baud Rate Port RS485 Baud rate for the CBC's RS-485 port. 

Baud Rate Port RS232 Baud rate for the CBC's RS232 port. 

Protocol Port RS485 Communications protocol for the CBC's RS-485 port (RCP or 
S3P). 

CBC S3P Address S3P address for the CBC (must be valid if protocol is S3P). 

CBC RCP Slave Address RCP address for the CBC (must be valid if protocol is RCP). 

 A ? indicates that no information has been received from the 
CBC. 

 

Port table 
This table lists the number of communicating CBC slave modules by CBC port. 
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Modem display area 
 You can change any of these values. 

 
 

Value Description 

Modem Indicates whether the CBC's modem is enabled or disabled. 

 Changing this value causes the CBC to reset. 

Auto Answer Rings Number of rings the modem must detect before it answers. 
• A value of zero disables auto-answer (disables dial-in). 
• Changing this value causes the CBC to reset. 

Primary Dial Out 
Number 

First dial-out phone number. 

Secondary Dial Out 
Number 

Second dial-out phone number. 

Connect Timeout Maximum time (in seconds) the CBC will wait for a modem 
connection to be established with the host. 

 
 

Maximum Retries Maximum number of times the CBC will attempt to re-dial a 
failed connection using the same phone number. 

Retry Interval The time the CBC will wait before making a re-dial attempt. 

Comms Timeout The time (in seconds) that must elapse with no data being 
received, before the CBC forces the modem to hang up, once a 
modem connection has been established. 

Modem Setup A setup string configuring the modem to operate correctly with 
the CBC. 

 Changing this value causes the CBC to reset. 

Maintenance Interval The time (in minutes) that the CBC will wait between attempts 
at determining whether or not a modem is attached. 
• If the modem does not respond, the CBC will try to 

initialize it. 
• A value of zero disables periodic testing that a modem is 

present. 
• Changing this value causes the CBC to reset. 

 A ? indicates that no information has been received from the CBC. 
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CBC Identity view 
The CBC Identity view shows the following identification parameter values at the CBC, and a 
button. Items are listed in display order, under each display area. 
 

Identity display area 
 The Editable column indicates values you can change. 

 
 

Value Editable Description 

Interface Version No Version number of CBC's software interface. 

Software Version No Version number of CBC software. 

Hardware Version Yes Version number of CBC hardware. 

System Type Yes CBC type, as configured in the CBC. 

System Location Yes CBC Location name, as configured in the 
supervisory module. 

System Serial Number Yes Power system's serial number, as configured in the 
CBC. 

CBC Serial Number No CBC’s serial number. 

Configuration Name Yes Name identifying latest configuration loaded into 
the CBC. 

Change Password button - Click to open the Change Password dialog. See 
Write Access Password Protection Option on page 
32. 

 A ? indicates that no information has been received from the CBC. 
 

Time Synchronization display area 
 

Item Description 

PC Date Time* The date and time as set in the PC. 

CBC Date Time* The date and time as set in the CBC's real-time clock. 

Synchronize button Click to set the CBC's real-time clock to the same date and time 
as the PC clock.  

* You cannot edit these values in this view. Use the CBC Summary view (see details on page 64) 
to edit the CBC date and time, and use Windows Control Panel to reset the PC date and time. 
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Characterization 

 
This view shows all battery Discharge Characterization data stored in the CBC and allows 
management of the data. 
This data is used to characterize the battery strings, which enables Remaining Charge and 
Remaining Time to be estimated during battery discharge. 
 

 

Input: Full Charge Discharge Log 

Graph and data 
The graph and data show all values recorded during the latest full discharge. 

 You cannot change these values. 
This display area has two main sub-areas. 
The Graph display area shows the Full Discharge graph for a selected string, as recorded by the 
CBC. This graph is a duplicate of that shown in the CBC Full Discharge Graph view (see that 
topic for more details). 

 

The Data area has six sub-areas of tabulated Full Discharge data. 
• The four String Datalog areas (1 through 4) duplicate the corresponding tables shown in 

the CBC Full Discharge Table view. 
• The Bloc End Ah area lists the Bloc End Ampere Hours values for each bloc, at the instant 

the bloc reached the Bloc End Voltage, as recorded during the last full discharge. 

 A value of 65535 indicates an unknown value. 
• The Trigger Rec Num area lists the triggering log record number for each string, as 

recorded during the last full discharge. This log record number corresponds to the time 
when the average Bloc Voltage over the string reached the Bloc End Voltage. 
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Characterization Algorithm 
This area contains a set of buttons you can use to re-characterize the battery strings. Each button 
resets the Discharge Characterization settings for a specific string to the corresponding Full 
Charge Discharge Log settings for that string. 
Click a String button to re-characterize that battery string. 
Each button resets the Discharge Characterization settings for a specific string (those shown in 
the display area below the buttons) to the corresponding Full Charge Discharge Log settings for 
that string (those shown in the display area above the buttons). 
 

 

Output: Discharge Characterization 

Graph and data 
The graph and data show all Characterization settings that are used currently for estimating 
Remaining Time and Charge values during battery discharge. 
This display area has two main sub-areas. 
The Graph display area shows the Discharge Characterization graph for a selected string, as 
stored in the CBC. This graph is a duplicate of that shown in the CBC Discharge 
Characterization Graph view (see that topic for more details). 

 

The Data area has two sub-areas of tabulated Discharge Characterization settings. 
• The String Average area duplicates the Average table shown in the CBC Discharge 

Characterization Table view. 
• The Bloc area duplicates the Average table shown in the CBC Discharge Characterization 

Table view. 

 You can reset these values by using the Characterization Algorithm buttons. 
 

Management 
These functions allow the characterization data to be easily copied between strings within a 
CellSure Battery Controller (CBC) and copied to another CBC by downloading/uploading the 
characterization data. 
This allows quicker setup and configuration of CellSure for repeat installations or for when only 
off-line battery discharge characterizations are allowed. 

 The initial accuracy of the installed CellSure system may be reduced. This is because the referenced 
data has been copied from other characterized batteries and may not accurately represent the 
installed batteries. This will be corrected after the next partial discharge test. 

 
 

Save to File ... Allows the data from one or all strings to be saved to file. 

Load from File ... Allows the data for one or all strings to be loaded from a file. 

Copy to >> Allows data from one string to be copied to other strings. 
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Alarms 

CBC Summary Alarm Table 
The CBC Summary Alarm table view shows the following items. 
• Summary alarm indicators (either, both, or none), where: 

 indicates that one or more urgent alarms apply. 

 indicates that one or more non-urgent alarms apply. 
• A table of all summary alarms showing each alarm's present state, where: 

 (in the Urgent Active column) indicates an active Urgent alarm. 

 (in the NonUrgent Active column) indicates an active Non-urgent alarm. 
• The Clear Cap. And SoH Alarms button, which you can click to clear all latching Battery 

Capacity and State of Health alarms. 
 

 

CBC String Alarm Table 
The CBC String Alarm Table view displays battery string alarm indications and related data. 
Items are listed in display order, under each display area. 

 You cannot change any values in this view. Use the CBC Alarm Configuration view to change 
alarm parameter settings. 

 

Summary area 
This area shows a table of the following items for each battery string. 
• String Current in Amps 
• A String Alarms icon, where no icon indicates that no alarms apply, and: 

 indicates that one or more urgent alarms are active for that string. 

 indicates that no urgent alarms apply, but one or more non-urgent alarms are active for 
that string. 

• One column for each bloc in the string, indicating blocs with and without alarms, where: 

 under the bloc number indicates that no urgent alarms apply, but one or more non-
urgent alarms are active for that bloc. 

 under the bloc number indicates that no alarms are active for that bloc. 
 

String Urgent Alarms area 
This table shows alarm indications for each Urgent battery string alarm (columns), by string 
(rows), where: 

 indicates that particular Urgent alarm is active for that string. 
- indicates that particular alarm is either not active for that string, or is not configured as 
Urgent. 
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String NonUrgent Alarms area 
This table shows alarm indications for each Urgent battery string alarm (columns), by string 
(rows), where: 

 indicates that particular Non-urgent alarm is active for that string. 
- indicates that particular alarm is either not active for that string, or is not configured as Non-
urgent. 
 

 

CBC Bloc Alarm Table 
The CBC Bloc Alarm Table view displays battery bloc alarm indications and related data. Items 
are listed in display order, under each display area. 

 You cannot change any values in this view. Use the CBC Alarm Configuration view to change 
alarm parameter settings. 

 

Summary area 
This area shows a table of the following items for each battery string. 
• String Current in Amps 
• A String Alarms icon, where no icon indicates that no alarms apply for that string, or: 

 indicates that one or more urgent alarms are active for that string. 

 indicates that no urgent alarms apply, but one or more non-urgent alarms apply. 
• One column for each bloc in the string, indicating blocs with and without alarms: 

 under the bloc number indicates that no urgent alarms apply, but one or more Non-
urgent alarms are active for that bloc. 

 under the bloc number indicates that no alarms are active for that bloc. 
 

Bloc Alarms area 
This area shows a table of alarm indications for each battery bloc (one row per bloc, in 
string/bloc order), where: 

 indicates a particular Non-urgent alarm that is active for that bloc. 
- indicates a particular alarm that is not active for that bloc. 
 

 

CBC Alarm Configuration 
The CBC Alarm Configuration view lists all configurable parameters related to CBC alarms. 
These parameters are listed below in display order, under each display area. 
You can change any of these values. 

 

Alarm table 
This table shows the following configurable settings for each alarm. 
 

Column  Description 

Urgent State Enabled The alarm can be Urgent (Urgent parameters must be 
set for this alarm). 

 Disabled The alarm cannot be Urgent. 

 Log only The alarm will be added to the CBC Log as Notify 
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Only, but not otherwise indicated. 

Urgent Alarm Report Yes The CBC will attempt to use the modem to dial out 
and connect to manager software when an Urgent 
alarm occurs. 

 No The CBC will not attempt to dial out when an Urgent 
alarm occurs. 

 Always set to No if there is no modem attached to 
the CBC. 

 
 

NonUrgent State Enabled The alarm can be Non-urgent (Non-urgent parameters 
must be set for this alarm). 

 Disabled The alarm cannot be Non-urgent. 

 Log only The alarm will be added to the CBC Log as Notify 
Only, but not otherwise indicated. 

NonUrgent Alarm 
Report 

Yes The CBC will attempt to use the modem to dial out 
and connect to manager software when a Non-Urgent 
alarm occurs. 

 No The CBC will not attempt to dial out when a Non-
Urgent alarm occurs. 

 Always set to No if there is no modem attached to 
the CBC. 

 

Specific alarm areas 
These display areas show threshold (and in some cases, time) parameter settings related to 
specific alarms or group of alarms, where applicable. 
Click + to open a particular display area. 

 

The following table summarizes these alarm parameters.  
 

Parameter Description 

Urgent Threshold Value the relevant system value must exceed or fall below 
before the specific Urgent alarm is activated. Optional. 

Urgent Alarm Time Time the relevant system value must remain beyond the 
Urgent Threshold before the specific Urgent alarm is activated. 
Optional. 

NonUrgent Threshold Value the relevant system value must exceed or fall below 
before the specific Non-urgent alarm is activated. 

NonUrgent Alarm Time Time the relevant system value must remain beyond the 
NonUrgent Threshold before the specific Non-urgent alarm is 
activated. Optional. 
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Note: 
• Alarms based simply on whether or not an event has occurred do not have threshold and 

time parameters, and thus have no display area (for example, Slave Communications 
Fault). 

• Alarms based on key system values going above or below a threshold will each have both 
an Urgent and Non-urgent threshold parameter (and in some cases a time parameter also). 
Less important alarms of this type will each have only a Non-urgent threshold parameter 
(and in some cases a time parameter). 

• A time parameter applies only where the system value must remain beyond the threshold 
for a specified time before the relevant alarm is activated. 

• A Non-Urgent Alarm Time value should be greater than the Urgent Alarm Time value for 
the same alarm. 

• All State of Health alarm threshold parameters are grouped in one display area for 
convenience (none of these have time parameters). 

 
 

CBC Logs 

CBC Event Logs table 
The CBC Event Logs table lists events logged by the CBC, in numeric (Record Number) 
sequence. 
When communications are first established, DCTools will upload all the CBC's logged events. 
After that, only new events are uploaded. 

 The CBC stores only the last 255 events. Thus if communications between DCTools and the CBC 
is broken for a period when more than 255 events are logged by the CBC, the oldest of these excess 
events will be lost to DCTools. 

 

Each row of the CBC Event Logs table represents one log entry. Each entry has the following 
values. 
 

Column Description 

Record Number Unique number for the event 

Time Stamp CBC's clock time when the event occurred 

Event Description Text description of the event 

 
 

CBC Datalog Graphs 
Each of these graph views shows a graph of battery string voltages over time or Charge 
Remaining (Discharge Characterization graph), based on data received from the CBC. Voltages 
are graphed for each bloc and for the average and total over all blocs in the string. 
You can view the following graphs. 
• Discharge Characterization 
• Full Charge Discharge Log 
• Partial Discharge Log A or B 
• Last Week Float Log 
• Last Year Float Log 
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Each graph view has the following display elements. 
 

  

String trackbar Drag the slide control to the string whose voltages you want to display 
(grayed-out  string numbers indicate uninstalled strings).   

 Click to see instructions for zooming the graph display in and out. 

 
Click to go to the table view for the same data. 

Highlight 
trackbar 

Drag the slide control to the voltage you want to highlight in the graph. 

Voltage (Y) axis Indicates the voltage (automatically adjusted to suit a bloc or string 
range, depending on your selected Highlight voltage). 

Time (X) axis Indicates the time (automatically adjusted to fit the applicable time 
range). 

Graph plot area Shows the selected graph lines: 
• Red dotted horizontal lines indicate Low and High 

Voltage alarm thresholds. 
• You can scroll, zoom in on an area, and out again (see 

below). 
  

► To zoom in on an area within the graph. 
1 In the graph, click and drag down to select the area to be enlarged. 
2 Release the mouse button. A magnified graph of that part of the graph is then displayed. 
 

 

► To zoom out to the full graph display 
1 In the graph, click and drag up and to the left to form a rectangle (of any size). 
2 Release the mouse button. The full graph area is then displayed. 
 

 

► To scroll the displayed graph area 
In the graph, using the right mouse button, drag in any direction. 
 

 

CBC Datalog Tables 
Each of these table views lists battery string values over time, based on data received from the 
CBC. 
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CBC Discharge Characterization Table 
This view shows tabulated Discharge Characterization data. 
This data is used to characterize each battery string, which enables Remaining Charge and 
Reserve Time values to be accurately estimated during battery discharge. 
The Average table shows, for each string, the Voltage and Charge Remaining at each discharge 
point, averaged over all blocs in the string. Values are listed in String number/discharge point 
order. 
The Bloc table shows the individual bloc values at each discharge point. Values are listed in 
String number/bloc number/discharge point order. 

 You can reset these values in the Characterization Algorithm view. 
 

CBC Full Charge Discharge Log Table 
This view shows tabulated data related to the previous Full Charge Discharge. 

 You cannot change these values. 
One table is displayed for each string. Each table is preceded by a Log Exists value, which 
indicates whether the CBC has collected data for that string or not. 
Each row of a table represents one logged set of data, and lists the following values. 
 

Value Description 

String String number. 

Record Number Unique number identifying a particular recording point and its 
data. 

Time Stamp Date and time the data was recorded (as indicated by the CBC's 
clock). 

Current String current, at the time indicated. 

AmpHours Discharged Total Ampere hours the string had discharged at that point. 

String Temperature String temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Ambient Temperature Ambient temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Bloc Voltage values Voltage of each bloc at the time indicated (a column per bloc). 

 
 

CBC Partial Discharge Log A and B tables 
These views show Partial Discharge Log A and Log B data, as recorded by the CBC. 
Two Partial Discharge Logs are recorded so that you can view details for both a partial 
discharge currently in progress and the previous one. The most recent Partial Discharge always 
alternates between Log A and Log B. 

 You cannot change these values. 
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One table is displayed for each string. Each table is preceded by a Log Exists value, which 
indicates whether the CBC has collected data for that string or not. 
Each row of a table represents one logged set of data, and lists the following values. 
 

Value Description 

String String number. 

Record Number Unique number identifying a particular recording point and its 
data. 

Time Stamp Date and time the data was recorded (as indicated by the CBC's 
clock). 

Current String current, at the time indicated. 

AmpHours Discharged Total Ampere hours the string had discharged at that point. 

String Temperature String temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Ambient Temperature Ambient temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Bloc Voltage values Voltage of each bloc at the time indicated (a column per bloc). 

 
 

CBC Last Week Float Log Table 
This view shows Float data, as recorded at hourly intervals by the CBC, over the last week. 

 You cannot change these values. 
One table is displayed for each string. Each table is preceded by a Log Exists value, which 
indicates whether the CBC has collected data for that string or not. 
Each row of a table represents one logged set of data, and lists the following values. 
 

Value Description 

String String number. 

Record Number Unique number identifying a particular recording point and its 
data. 

Time Stamp Date and time the data was recorded (as indicated by the CBC's 
clock). 

Current String current, at the time indicated. 

String Temperature String temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Ambient Temperature Ambient temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Bloc Voltage values Voltage of each bloc at the time indicated (a column per bloc). 
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CBC Last Year Float Log Table 
This view shows Float data for a selected string, as recorded at weekly intervals by the CBC, 
over the last year. 

 You cannot change these values. 
One table is displayed for each string. Each table is preceded by a Log Exists value, which 
indicates whether the CBC has collected data for that string or not. 
Each row of a table represents one logged set of data, and lists the following values. 
 

Value Description 

String String number. 

Record Number Unique number identifying a particular recording point and its 
data. 

Time Stamp Date and time the data was recorded (as indicated by the CBC's 
clock). 

Current String current, at the time indicated. 

String Temperature String temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Ambient Temperature Ambient temperature in degrees Celsius or Fahrenheit, as 
applicable. 

Bloc Voltage values Voltage of each bloc at the time indicated (a column per bloc). 
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PC Logs (CBC) 

PC Datalog (CBC) 
Use the PC Log view to optionally set regular automatic logging of the CBC's main system 
values and all alarm states to a specified text file (in comma-separated format suitable for 
loading into Microsoft Excel). 
The PC Log view lists (at left) the main system values that will be saved, and has the following 
display items. 
 

 
 

Elapsed time Countdown time remaining to the next logging point. 

Start button Click to start saving logged system values and alarms to the specified 
file, at the specified interval. 

Stop button Click to stop saving logged values. 

File name The file logged values and alarms are saved in (see Notes below)Click  
to browse for an existing file, or edit the filename directly.  

Time Interval Interval between logging points (when values and alarms are 
saved)Drag the slide control to the value required (between 5 seconds 
and 60 minutes). 

Notes: 
• If you save to an existing file, DCTools will add all log entries to the end of that file, after 

any previous entries. 
• The first record in a file is a header giving the names of the saved system data items and 

alarms (these show as the column headings when the file is loaded into Excel). 
 

 

CBC Bloc Voltage Trend Graph 
This view shows a graph of logged Bloc Voltage data for a selected bloc or string, as recorded 
by the CBC over the last year. 

 

Each graph view has the following display elements. 
 

  

String trackbar Drag the slide control to the string whose voltages you want to 
display (grayed-out  string numbers indicate uninstalled strings).   

 Click to see instructions for zooming the graph display in and out. 

  Click to clear the logged values. Only new data will then be plotted. 

Highlight trackbar Drag the slide control to the voltage you want to highlight in the 
graph. 

Voltage (Y) axis Indicates the voltage (automatically adjusted to suit a bloc or string 
range, depending on your selected Highlight voltage). 

Time (X) axis Indicates the time (automatically adjusted to fit the applicable time 
range). 

Graph plot area Shows the selected graph lines: 
• Red dotted horizontal lines indicate Low and High Voltage 

alarm thresholds. 
• You can scroll, zoom in on an area, and out again (see below). 
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► To zoom in on an area within the graph. 
1 In the graph, click and drag down to select the area to be enlarged. 
2 Release the mouse button. A magnified graph of that part of the graph is then displayed. 
 

 

► To zoom out to the full graph display 
1 In the graph, click and drag up and to the left to form a rectangle (of any size). 
2 Release the mouse button. The full graph area is then displayed. 
 

 

► To scroll the displayed graph area 
In the graph, using the right mouse button, drag in any direction. 
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A p p e n d i x  A  
Control Processes 

Voltage Control 
The output voltage of the rectifiers is controlled by a number of control processes. The 
following diagram shows the various control processes, measured values and operating values 
that determine the rectifier output voltage. 

 If ac fails then any active control process stops. No control process can start until the ac supply is 
restored. 

 

 
 

 
 

Active Voltage Control 
Active Voltage Control (AVC) maintains a constant float voltage under varying load current by 
monitoring the bus voltage and adjusting the rectifier output voltage to compensate for any 
voltage drop. 
Enable AVC to prevent undercharging the batteries during high load demand. 

 Active Voltage Control does NOT function during a Battery Test or if the battery current is 
negative. 

 
To configure AVC see Active Voltage Control on page 53. 
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Battery Current Limit (BCL) 
Battery Current Limit automatically limits the battery recharge current to: 
• Prevent excessive battery charge current in under-loaded systems 
• Minimize gas release in VRLA batteries 
• Reduce the load on a standby generator. 
 
Two current limit values can be set (both are a percentage of the C10 rating of the battery): 
 

 Battery Current Limit (Normal Limit): 
 

BCL value for use when utility ac is available. 

 Engine Run Limit (optional): BCL value for use when ac is supplied by a standby 
generator. This reduces the load on the generator 
and allows a smaller generator to be used. 

 

 Engine Run Limit is activated by a signal from an ac standby generator. 
 
To configure BCL see Battery Current Limit on page 55. 
 

 

Battery Mid-point Monitoring (MPM) 
Battery Mid-point Monitoring provides a cost-effective method for the early detection of 
internal battery faults. The voltages of the two halves of a battery string are measured and the 
system controller generates an alarm signal if a voltage imbalance is detected. 
A voltage imbalance is an indication that one or more cells has an internal fault. Further 
investigation can then isolate the faulty cell(s) and action can be taken to correct the problem 
and prevent a total battery failure. 
To connect the Battery Mid-point Monitoring option see details in the dc power system 
installation guide. If a String Fail alarm is generated see Troubleshooting. 
To ensure reliable operation Mid-point Monitoring operates only when the battery is in float 
charge and after a configurable lockout period since the last battery discharge, Fast Charge, 
Equalize or Battery Test. 
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Battery Test 
Battery Test is a preventative maintenance tool that monitors the discharge capabilities to 
ensure that the condition of the battery has not deteriorated over time. 
The system controller temporarily reduces the output voltage of the rectifiers to just below the 
bus voltage for a set duration. The battery then supplies power to the load. A battery test passes 
if the battery voltage remains above a predetermined level for the duration of the test. 
Battery Tests can be scheduled to occur at regular intervals, and/or can be started/stopped 
manually, and/or can be started by an external relay contact or switch. 

 Battery Test does NOT function during a Fast Charge or Equalize, or during the lock-out period 
after an ac supply failure. 

 If a Digital Input has the function "Start Battery Test" then a Battery Test will start when the 
Digital Input becomes active. 

 
To configure see Battery Test on page 55. 
 

 

Battery Time Remaining 
The system controller obtains characterization data from either periodic battery discharges 
(SC100) or every full battery discharge (SC200) (to the specified end voltage). 
During a battery discharge, the system controller uses this characterization data to calculate an 
estimated time until the battery will reach a specified end voltage. 

 If a battery disconnect LVD is fitted then the end voltage will usually be the voltage at which the 
LVD disconnects the battery. 

 Battery Time Remaining is designed for a constant power load. The accuracy of the time 
remaining calculation will be reduced if the dc power system is connected to a predominantly 
resistive (constant current) load. 

 
 

Current Share 
Current Share ensures that the total output power of the power system is evenly shared 
between all rectifiers. 
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Equalize 
Equalize charges batteries at a higher voltage after they have been fully charged to ensure that 
all individual cell voltages are the same, that electrolyte is distributed evenly, and that sulfate 
crystal buildup on the plates is reduced. 
Equalize can be scheduled to occur at regular intervals and/or can be started/stopped 
manually. 

 Refer to the battery manufacturer's instructions before using Equalize. 

 If a Digital Input has the function "Start Equalize" then a manual equalize cycle will start when 
the Digital Input becomes active. 

If Equalize cannot start at the scheduled time (for example when there is no ac supply) then its 
state will be Pending and it will start as soon as conditions allow. Use Stop Equalize to cancel a 
Pending Equalize. 
 
 
 
To configure see Equalize on page 54. 
 

 

Fast Charge 
After an ac supply failure, Fast Charge automatically increases the float voltage of the power 
system to recharge the batteries as quickly as possible. 
Enable Fast Charge if the site experiences frequent ac supply failures. 

 Fast Charge does NOT function during a Battery Test, Equalize or if the battery current sensor 
fails. 

 If Fast Charge is used then Battery Current Limit (BCL) should also be used. See Battery Current 
Limit on page 88 for details. 

 
To configure see Fast Charge on page 54. 
 

 

Generator Control Option  (SC200 only) 
Generator Control is used to delay the start of standby ac generators until the batteries are 
partially discharged (rather than immediately after the ac supply fails). This can save fuel by 
preventing generators running during short ac supply failures. It can also be used to control a 
generator in a hybrid power system (cyclic charge/discharge). 
Generator Control uses a digital output (relay) which is connected in series with the generator 
run signal of the generator controller. The relay is controlled by the Generator Enable alarm. The 
relay contacts interrupt the generator run signal until the Generator Enable alarm is active. 
The Generator Enable alarm is activated when the ac supply fails and either the Fast Charge or 
Equalize control process starts (depending on the setting of the Generator Start Trigger). 
The Generator Enable alarm stays active (and the generator running) until the ampere-hours 
recharged is enough for the battery to be fully charged, or until the maximum fast charge 
duration is reached. 
A Generator Fail alarm is activated if the system controller does not detect that the ac supply is 
present (rectifiers have turned on) after the Generator Fail Alarm Recognition Period following 
Generator Enable becoming active. 
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Single line diagram 
 

 

 AC utility supply 

 Generator 

 AC change-over switch 

 Rectifiers 

 Generator control panel 

 Normally open (NO) relay 
contacts on I/O board 
interrupt Generator Run 
signal. 

 

Typical operation 
 

AC Supply 

 
Battery Discharge 

Generator Run 

Generator Fuel 
Savings  

 
 

 AC supply failure. Battery starts to discharge. 

 AC supply restored. Battery begins to recharge. Battery discharge did not reach the Ah Threshold. Generator 
Enable was not active (relay contacts did not close) so the generator did not run. 

 AC supply failure. Battery starts to discharge. 

 Battery discharge reaches the Ah Threshold. Generator Enable becomes active and the relay contacts close. 
The Generator Run circuit is completed allowing the generator to start. Battery begins to recharge. 

 Battery recharge is complete. Generator Enable becomes inactive and the relay contacts open. The 
Generator Run circuit is interrupted causing the generator to stop. Battery begins to discharge. 

 AC supply restored. Battery begins to recharge. Battery discharge did not reach the Ah Threshold. Generator 
Enable was not active (relay contacts did not close) so the generator did not run. 
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Load Based Rectifier Shutdown 
Load Based Rectifier Shutdown (LBRS) automatically shuts down rectifiers when the total load 
current is significantly less than the total rectifier capacity. 
This raises the average load on the remaining rectifiers which will then operate at a higher 
efficiency. This results in a decrease in total power consumption. 

 Rectifiers shut down by LBRS will have the  (red) alarm LED on. 

 Rectifiers shut down by LBRS can be temporarily restarted from the system controller keypad or 
DCTools using the Rectifier Restart function. See details in the System Controller Operation 
Handbook. 
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Low Voltage Disconnect (LVD) 
Low Voltage Disconnects (LVDs) can be connected either as load or battery disconnect and have 
two purposes: 
• to protect a VRLA battery from deep discharge and premature failure, and/or 
• to reduce the load on a battery under discharge so that high priority equipment operates 

for a longer time after an ac supply failure.  
Eaton system controllers have the following LVD functionality. 
 
 

 SC200 Other 
system 

controllers 

Comment 

Maximum number 
of LVD channels 

16* 2 *SC200 systems require 
additional IOBGP boards. 

Maximum number 
of LVD contactors 

16* 2  

Voltage disconnect    

Slave Mode Map multiple 
contactors to same 

channel. 

 LVD2 will mirror the 
operation of LVD1. 

AC Timer based 
disconnect 

 Some The LVD will disconnect 
either after the AC Timer 
Disconnect Delay, or if the bus 
voltage drops to the Disconnect 
Voltage. 

Chained to Previous  - The LVD will disconnect if 
one of its disconnect 
conditions is true and the 
previous LVD is disconnected. 

Smart Alarm 
Disconnect 

 - The LVD will disconnect if a 
specified Smart Alarm is active. 

Auxiliary 
Temperature 
disconnect 

Use Smart Alarm 
Disconnect. 

SM40 and SC100 
only 

The LVD will disconnect if an 
auxiliary temperature sensor 
is out of range. 

 
To configure LVDs see Low Voltage Disconnect on page 57. 
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Temperature Compensation 
As the ambient temperature of a battery drops (or rises) the voltage required to maintain full 
charge increases (or decreases). Temperature Compensation automatically varies the float 
voltage to cancel the effects of changing temperature. 
Enable Temperature Compensation for optimum battery life and battery capacity over a wider 
temperature range. 
Temperature Compensation does NOT function during a Battery Test. 
To configure see Temperature Compensation on page 53. 
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A p p e n d i x  B  
Glossary of Terms 

 
 

AC Fail Recognition Period 
An AC Fail condition must be continuously active for this period before an AC Fail alarm is 
generated. 

 

AC Timer Disconnect Delay (LVD1) 
If Enable AC Timer is set then LVD1 will disconnect after the Disconnect Delay from the start of  
an ac supply failure, unless Disconnect Voltage is reached first. 

 

AC Timer Disconnect Delay (LVD2) 
If Enable AC Timer is set then the LVD2 will disconnect after the LVD2 AC Timer Disconnect 
Delay from the start of  an ac supply failure, unless LVD2 Disconnect Voltage is reached first. 

 

AC Voltage 
The ac voltage measured by the rectifier. 

 

Active (HTTP) 
Indicates this user is enabled or disabled. 

 

Active State (Digital Inputs) 
If the input is in this state for the alarm recognition time then an alarm will be activated. 

 

Active State (Digital Outputs) 
Active state of the digital output (Energized or De-energized). 

 

Active Voltage Control 
When AVC is enabled the rectifier output voltage is adjusted to maintain the bus voltage at the 
configured float voltage (plus or minus any adjustments by active control processes) within a 
predefined dead band. Enable AVC unless there is specific reason to disable. 

 

Ah Discharged 
The current level of battery discharge. Used to start a Fast Charge cycle if this value is above the 
Fast Charge Ampere Hour Threshold. 

 

Alarm (Digital Inputs) 
The state of this alarm. 

 

Alarm Recognition Period 
An alarm condition must be continuously active for this period before an alarm is generated. 

 

Alarm Report 
This indicates that the dial-out process will start when an alarm occurs. 

 

Allow Front Panel LVD Control 
If true LVD manual control from the front panel is allowed. 
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Ampere Hour Threshold (Fast Charge) 
If Fast Charge Ah Discharged is above this value, then Fast Charge occurs when the ac supply is 
restored. The threshold is given as a percentage of installed C10 battery capacity. Fast charge 
can also be triggered based on the Fast Charge Voltage Threshold. 

 

AVC 
Active Voltage Control. 

 

Backup (HTTP) 
When set true the user is allowed to download configuration or snapshot. 

 

Backup Address (SNTP) 
IP address of Backup SNTP server. 

 

Base Voltage 
The voltage sent to the rectifiers. This is the Target Voltage plus the AVC Offset. 

 

Battery Capacity 
The rated 10-hour (C10) capacity of the battery. 0 = no battery is installed. 

 

Battery Characterization (CellSure) 
Battery Characterization is the process used by a CellSure Battery Controller (CBC) to obtain the 
discharge data it uses to calculate the battery performance. 
DCTools has a Characterization Data Management feature that enables CellSure battery 
characterization data to be copied for other strings of the same type and size. This can reduce 
the time needed to characterize batteries. 

 

Battery Characterization (SC100/SC200) 
The system controller obtains characterization data from either periodic battery discharges 
(SC100) or every full battery discharge (SC200) (to the specified end voltage). 
During a battery discharge, the system controller uses this characterization data to calculate an 
estimated time until the battery will reach a specified end voltage. 

 

Battery Current 
The total current flowing to/from the batteries derived from the sum of any current inputs 
mapped as battery shunts. If no input is mapped and a load current is available, the battery 
current is calculated as Rectifier Current - Load Current, otherwise it is unavailable. If positive, 
the battery is being charged. 

 

Battery Current Limit 
Protects the batteries from excessive charge current. BCL varies the system voltage in order to 
maintain battery charge current below the Battery Current Limit value. 

 

Battery State 
Indicates the battery state (charge, discharge or float). 

 

Battery Temperature 
The temperature measured by the battery temperature sensor. 
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Battery Temperature High Threshold 
Battery Temperature High alarm is activated if the battery temperature is above this value. 

 

Battery Temperature Low Threshold 
Battery Temperature Low alarm is activated if the battery temperature is below this value. 

 

Battery Test 
Periodically tests the condition of the battery by reducing the rectifier voltage and allowing the 
batteries to discharge into the normal load. 

 

Battery Time Remaining 
During a battery discharge, the system controller uses stored battery characterization data to 
calculate an estimated time until the battery will reach a specified end voltage. 

 

Bus Voltage 
The system bus voltage from the bus voltage sensor. If the bus voltage sensor has failed, the 
system bus voltage is determined from the rectifier output voltages. 

 

Cells Per String 
The number of 2V battery cells per string. Zero means no battery is installed. 

 

Communications Options dialog - Overview 
Use this dialog to configure general communications options for the DCTools connections. 
You must do this before enabling communications and attempting to poll any supervisory 
modules or CellSure Battery Controllers for the first time. 
Before you change any communications configuration parameters using this dialog, check no 
connections are active. 
For more details, see Setting Global Communications Options on page 10. 

 

Compatible Interface Version 
The earliest interface version this controller is compatible with. Compatible means all existing 
communications commands are unchanged, although additional commands may have been 
added. This means that any management tool (including DCTools or PowerManagerII) that is 
compatible with this version can safely talk to this controller, ignoring the extra items it does 
not recognize. 

 

Configuration Name 
Name of the configuration in the controller database. 

 

Contact (Identity) 
Contact details for the person responsible for this dc power system. 

 

Current (Rectifier) 
The current produced by this rectifier. This is measured by the rectifier and reported via the 
rectifier comms bus. 

 

Current Limit (Battery) 
BCL maintains the battery current below this value, which is a percentage of the installed C10 
Battery Capacity. 
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Data Log 
The Data Log records several system parameters (AC Voltage, Bus Voltage, Load Current, 
Rectifier Current, Battery Current, Battery Temperature) at specified intervals. The rate of 
recording increases (interval is reduced) when the bus voltage differs from the float voltage by 
more than a specified value. 
Data log entries are also written whenever a system event occurs (as for the Event Log). 
The number of records depends on the Device. When the memory is full the oldest record will 
be over-written. 

 

DCTools 
DCTools is Microsoft® Windows® based software for control and management of Eaton dc power 
systems. DCTools allows the viewing, editing, and back-up of configuration file data. 

 

Device 
The Eaton dc power system controller with which DCTools communicates. This may be a 
supervisory module, a system controller or a CellSure Battery Controller. 

 

Dial Out Number 
The telephone numbers to be called (via a modem) if alarm reporting is enabled. Consult the 
modem documentation for appropriate dial modifiers to use with the ATD command. Leave 
blank to prevent dial-out. 
Enter any valid dialing number, up to 23 digits long, including dummy spaces and hyphens (-). 
A comma can also be inserted where you want a pause in the dialing – for example, to wait for 
an additional dial tone, as in dialing out through a PABX. 

 

Digital Output mapping A (Alarm States) 
Optional digital output activated while this alarm is active. 

 

Digital Output Mapping A (Digital Inputs) 
Optional digital output activated while this digital input is active. 

 

Digital Output mapping B (Alarm States) 
Optional second digital output activated while this alarm is active. 

 

Digital Output Mapping B (Digital Inputs) 
Optional digital output activated while this digital input is active. 

 

Disconnect Voltage (LVD1) 
If the bus voltage drops to this value, then any shutdown rectifiers are restarted (even if LVD is 
disabled). If the bus voltage is still lower than this value after the LVD1 Recognition Period, the 
LVD1 will disconnect. 

 

Disconnect Voltage (LVD2) 
If the bus voltage drops to this value after the LVD2 Recognition Period, the LVD2 will 
disconnect. This parameter is ignored if Enable LVD2 Slave Mode is Enabled. 

 

Display Orientation 
The orientation of the LCD. 
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Duration (Battery Test) 
The maximum time a Battery Test process will be active. The Battery Test will pass if the bus 
voltage remains above the Battery Test Termination Voltage for the duration of the test. 

 

Duration (Equalize) 
The duration of a scheduled Equalize. 

 

Edit User List (HTTP) 
When set true the user has access to database items that require Admin user access level. 

 

Elapsed Time (Fast Charge) 
The time the current Fast Charge cycle has been active. This timer is started when a Fast Charge 
cycle starts and is running while Fast Charge remains active. It is suspended and resumed when 
Fast Charge is suspended and resumed respectively. The Fast Charge cycle will stop if this 
timer reaches the configured maximum value. 

 

Enable AC Timer (LVD1) 
LVD1 will disconnect after the AC Timer Disconnect Delay, even if the Disconnect Voltage is not 
reached. 

 

Enable AC Timer (LVD2) 
LVDs will disconnect after the AC Timer Disconnect Delay, even if the Disconnect Voltage is not 
reached. 

 

Enable Audible Alarm Indication 
Enable/disable audible alarm indication. 

 

Enable High Float Tracking 
The alarm thresholds will be increased when the operating voltage is raised by a voltage control 
process. 

 

Enable Low Float Tracking 
The alarm thresholds will be reduced when the operating voltage is lowered by a voltage 
control process. 

 

Enable Modem 
Determines whether or not the RS232 port is configured to work with a modem. 

 

Enable Slave Mode (LVD2) 
LVD2 will disconnect and reconnect at the same voltages as LVD1. The LVD2 configuration 
parameters are ignored. 

 

Engine Run Limit 
The Battery Current Limit setting when Engine Run is active. BCL maintains the battery current 
below this value when the Engine Run digital input is active (Engine Run is enabled). This limit 
is expressed as a percentage of the installed C10 Battery Capacity. 

 

Equalize 
Raises the battery charge voltage to re-distribute the battery electrolyte. 
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Event Log 
The Event Log records every system event. The number of records depends on the Device. 
When the memory is full the oldest record will be over-written. 

 

Execute Commands (HTTP) 
When set true the user has access to database items that require Execute user access level. 

 

Fast Charge 
After an ac supply failure, Fast Charge automatically increases the float voltage of the dc power 
system to recharge the batteries as quickly as possible. Enable Fast Charge if the site experiences 
frequent ac supply failures. 

 

First Date / Time (Battery Test) 
The date and time that the first Battery Test will occur. Subsequent tests will occur at every 
Battery Test Interval after that. 

 

First Date / Time (Equalize) 
The date and time that the first scheduled Equalize will occur. Subsequent Equalize cycles will 
occur at every Equalize Interval after that. 

 

Float Voltage 
The voltage required to maintain optimum battery charge (at the nominal ambient 
temperature). Use the value recommended by the battery manufacturer. The bus voltage will be 
adjusted above or below this value by Temperature Compensation, Active Voltage Control, 
Equalize. 

 

Function (Analog Inputs) 
Selects the function of this input. The function selects how the value of this analog input is to be 
used by any control processes, if at all. 

 

Function (Digital Inputs) 
Selects the function of this input. The function selects how the value of this digital input is to be 
used by any control processes, if at all. 

 

Gain (Analog Inputs) 
The scaling factor applied to the raw value read from the I/O board. 

 

Gateway Address (Ethernet) 
Allows access to IP addresses outside your sub-network. Consult your network administrator. 

 

Generator Control 
Generator Control is used to delay the start of standby ac generators until the batteries are 
partially discharged (rather than immediately after the ac supply fails). This can save fuel by 
preventing generators running during short ac supply failures. It can also be used to control a 
generator in a hybrid power system (cyclic charge/discharge). 

 

Group (Analog Inputs) 
The group tag used by PowerManagerII to group related inputs and outputs for display 
purposes. 
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Group (Digital Inputs) 
The group Number to be used by SiteManager. 

 

Group (Digital Outputs) 
The Group Number to be used by SiteManager. 

 

Hardware Version 
The Product Hardware Version. 

 

Hardware Version (RXP Devices) 
Hardware Version of the RXP device. 

 

Heatsink Temperature (Rectifier) 
The measured rectifier heatsink temperature. 

 

High Digital Output Mapping A (Analog Inputs) 
Optional digital output activated while this alarm is active. 

 

High Digital Output Mapping B (Analog Inputs) 
Optional digital output activated while this alarm is active. 

 

High Float Threshold 
High Float alarm is activated if the bus voltage is above this value. 

 

High Load Threshold 
High Load alarm is activated if the bus voltage is above this value. 

 

High Note (Analog Inputs) 
User notes about this alarm. These notes appear in SNMP traps and can be viewed using 
DCTools or PowerManagerII. 

 

High Severity (Analog Inputs) 
The severity level associated with the alarm. Digital output-only alarms are not displayed, 
although any configured digital outputs are still activated. 

 

High State (Analog Inputs) 
The state of the selected analog input high alarm. 

 

High Threshold (Analog Inputs) 
An analog input high alarm is activated if the scaled input is greater than or equal to this value. 

 

Hold In Value (LVD) 
The voltage which the IOB applies to hold the LVD in the connected state. 

 

Host Name (Ethernet) 
The Internet Protocol (IP) Host Name. Depending on your network configuration, the host 
name may be able to be used as an Internet Protocol (IP) address rather than the numeric IP 
Address. Consult your network administrator. 
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HTTP Access 
If Enabled, HTTP Web interface access is allowed. 

 

HTTPS Access 
If Enabled, HTTPS (SSL) Web interface access is allowed. 

 

Hysteresis (Analog Inputs) 
The amount of hysteresis applied to the input before an active alarm is deactivated. 

 

Idle Auto-Disconnect Timeout 
(Applies only to modem connections.)  
This value has little effect unless one modem is being shared (or calls are charged per minute). 
In the case of the shared modem, this value should be set as short as possible to maximize the 
availability of the modem for callback. 

 

Inhibit Period (LVD) 
The minimum time an LVD stays connected or disconnected before it can change state. 

 

Interface Version 
S3P interface version. As the embedded software is upgraded, the communications interface 
may change. This number reflects any such change. This value, along with Compatible Interface 
Version is used by DCTools to determine how to communicate. 

 

Interval (Battery Test) 
The time between scheduled Battery Tests. The interval period begins at the start of a Battery 
Test. Zero disables scheduled Battery Tests. Zero also disables the 48 hour lockout following an 
ac supply failure, allowing an immediate manual test. 

 

Interval (Equalize) 
The time between scheduled Equalize cycles. The interval period begins at the start of an 
Equalize. Zero disables scheduled Equalizes. 

 

IOB AI Number (Analog Inputs) 
The input channel on the I/O board of this analog input. 

 

IOB DI Number (Digital Inputs) 
The input channel on the I/O board of this digital input. 

 

IOB DO Number (Digital Outputs) 
The number of the digital output channel on the I/O board. 

 

IOB LVD Number (LVD) 
The LVD connector on the I/O board that this LVD is connected to. 

 

IOB Number (Analog Inputs) 
The I/O board number on which this analog input is located. 

 

IOB Number (Digital Inputs) 
The I/O board number on which this digital input is located. 
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IOB Number (Digital Outputs) 
The I/O board number on which this digital output is located. 

 

IOB Number (LVD) 
The number of the I/O board that this LVD is connected to. 

 

IP Address (Ethernet) 
The Internet Protocol (IP) address. This value and the Subnet Mask must be set correctly to 
communicate using Ethernet. Consult your network administrator. 

 

IP Address (SNMP Receiver) 
SNMP notifications of events are sent to this IP address. 

 

LDR Software Version 
Bootloader software version. The bootloader is responsible for loading and running the system 
support software and the main application. 

 

Level (SMS Notifications) 
If an alarm becomes active or inactive, with severity level equal to or higher than this setting, 
the designated SMS Phone Number will be sent an SMS notification. 

 

Level (SNMP Receiver) 
When to send a trap to the receiver. 

 

Load Based Rectifier Shutdown 
Automatically shuts down rectifiers based on load. Rectifier shutdown flag must also be 
enabled. 

 

Load based Run Time (Rectifier) 
The time the rectifier has been operating since it was registered. 

 

Load Current 
The total current drawn by all loads derived from the sum of all current inputs mapped as load 
shunts. If no input is mapped and a battery current is available, the load current is calculated as 
Rectifier Current - Battery Current, otherwise it is unavailable. 

 

Load Power 
The power being supplied to the load. 

 

Lockout Remaining (Battery Test) 
How much longer the Battery Test is locked-out. Battery Tests cannot be started within 48 hours 
of an ac supply failure. If an immediate test is required, set Battery test Interval to zero (this 
disables the 48 hour lockout). 

 

Logon ID (HTTP) 
The logon name of a user. 
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Logon Script button 
(Applies only when a modem is selected in Connect Using and Modem Logon Required is 
selected.)  
Click this button to go to the Modem Script dialog, where you can define and edit a Modem 
Logon script to be used when the selected modem is connecting to the remote modem at the 
selected supervisory module or CellSure Battery Controller.  

 

Logon Window 
Enter the Write Access Password. 

 

Low AC Threshold (Rectifier) 
If the ac input voltage is below this value the rectifier will limit input current. 

 

Low Digital Output Mapping A (Analog Inputs) 
Optional digital output activated while this alarm is active. 

 

Low Digital Output Mapping B (Analog Inputs) 
Optional digital output activated while this alarm is active. 

 

Low Float Threshold 
Low Float alarm is activated when the bus voltage is below this value. 

 

Low Notes (Analog Inputs) 
User notes about this alarm. These notes appear in SNMP traps and can be viewed using 
DCTools or PowerManagerII. 

 

Low Severity (Analog Inputs) 
The severity level associated with the alarm. Digital output-only alarms are not displayed, 
although any configured digital outputs are still activated. 

 

Low State (Analog Inputs) 
The state of the selected analog input low alarm. 

 

Low Threshold (Analog Inputs) 
An analog input low alarm is activated if the scaled input is lower than or equal to this value. 

 

Low Volts Disconnect 1 Enable 
Enables operation of LVD1. If two LVDs are used, LVD1 may be used to connect non-essential 
load that may be disconnected during an ac supply failure to extend battery hold-up time and 
protect the essential load. 

 

Low Volts Disconnect 2 Enable 
Enables operation of LVD2 (if used). If two LVDs are used LVD2 can be used to disconnect the 
essential load, or the batteries, that should be only disconnected after LVD1 has disconnected. 

 

Lower Limit (Temperature Compensation) 
No additional voltage adjustment is made below this temperature. 
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Manufacturer Name 
The name of the manufacturer. 

 

Max Duration (Fast Charge) 
The maximum duration of a Fast Charge (use the value recommended by the battery 
manufacturer). 

 

Maximum Current Limit (Rectifier) 
The maximum current limit value of the rectifier. Adjust Rectifier Current Limit to set a lower 
operating current limit. 

 

Maximum Number of Log Entries (Data Log Configuration) 
The size of the data log. 

 

Maximum Number of Log Entries (Event Log Configuration) 
The size of the event log. 

 

Maximum Power Limit (Rectifier) 
The maximum output power limit value of the rectifier. Adjust Rectifier Current Limit to set a 
lower operating power limit. 

 

Maximum System Voltage 
The maximum voltage the live bus may be set to. Do not set above 58.0V. The actual bus voltage 
may be adjusted up to this value by Fast Charge, Equalize or AVC. 

 

Minimum System Voltage 
The minimum voltage the live bus may be set to. The actual bus voltage may be adjusted down 
to this value by control processes such as AVC and Battery Current Limit. 

 

Modbus 
Modbus is a communications protocol for industrial networks and building management 
systems (BMS). 

 

Mode (SNMP Receiver) 
Set to Normal traps to send normal traps to a Network Management System on alarm activation 
and deactivation. Set to Acknowledged Summary Traps to send summary traps to 
PowerManagerII. These traps are repeated until PowerManagerII receives the trap, connects to 
the controller, and downloads alarms and data. 

 

Modem Auto Answer Rings 
Number of rings before an incoming call is answered. Setting this parameter to zero disables 
incoming calls (the modem can still be used for alarm reporting). 

 

Modem Logon 
(Applies only when a modem is selected in Connect Using.) 
Select this option if the selected modem has security features, and you want it to use a Modem 
Logon script when establishing connection with the remote modem at the site.  
(Click Logon Script to view and edit the script for the connected Device.) 
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Modem Maximum Retries 
If an alarm report dial-out does not connect with a remote modem, then this number of 
subsequent alarm report attempts will be made on the current dial-out number before trying 
the next dial-out number from the Dial Out Number Table. Dialing will stop if none of the 
numbers in the Dial Out Number Table connect. 

 

Modem Power Reset 
If this is enabled, then an attempt will be made to reset a non-operating modem by turning its 
power supply off and on using digital output 2. 

 

Modem Retry Interval 
If an alarm report dial-out does not connect with a remote modem, then another attempt will be 
made after this time interval. 

 

Modem Set up String 
The string sent to the modem on reset. The modem AT command should not be included as it is 
automatically sent. The Auto-Answer Rings parameter is also sent, so it does not need to be 
included here. For complete details of appropriate commands, consult your modem 
documentation. 

 

Name (Analog Inputs) 
The name of this analog input channel as it will appear on management software such as 
DCTools or PowerManagerII. This name is not displayed on the controller. 

 

Name (Digital Inputs) 
The name of  the digital input. 

 

Name (Digital Outputs) 
The name of the digital output. 

 

Name (RXP Devices) 
Name of the RXP device. 

 

Name (SMS Notifications) 
A name to identify this phone. 

 

Name (SNMP Receiver) 
Name used to identify the receiver. 

 

Next Start Time (Battery Test) 
The start time of the next scheduled Battery Test. 

 

Next Start Time (Equalize) 
The start time of the next scheduled Equalize cycle. 

 

Normal Interval (Data Log Configuration) 
The time between each data log record when the Bus Voltage differs from the Float Voltage by 
less than the Data Log Off Normal Offset Voltage. Data log entries are also written whenever an 
event is logged. 
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Notes (Alarm States) 
User notes about this alarm. These notes appear in SNMP traps and can be viewed using 
DCTools or PowerManagerII. 

 

Notes (Digital Inputs) 
User notes about this alarm. These notes appear in SNMP traps and can be viewed using 
DCTools or PowerManagerII. 

 

Number of Dial Attempts 
(Applies only to networks using modem connections.)  
The maximum number of unsuccessful re-dial attempts Connection Manager will make to a 
Device via a modem, before displaying a Failed status for that connection.  

 Connection Manager will not re-dial until the Retry Wait time has expired. 
 

Off-Normal Interval (Data Log Configuration) 
The time between each log record when the Bus Voltage differs from the Float Voltage by more 
than the Data Log Off Normal Offset Voltage. 

 

Off-Normal Offset Voltage (Data Log Configuration) 
The Off Normal Log Interval will apply when bus voltage is outside the range: float voltage ± 
Off Normal Log Offset. Off normal condition transitions is recognized within 10 seconds. 

 

Offset (Analog Inputs) 
The offset applied to the raw value read from the I/O board. 

 

Operating Voltage 
This voltage is usually the Float Voltage (but can be the Fast Charge Voltage or Equalize 
Voltage if either is active) adjusted by Temperature Compensation. Or, it is the Battery Test 
Voltage if Battery Test is active with Fast Charge and Equalize inactive. 

 

Output Ramp Up Slope (Rectifier) 
The ramp-up slope of the rectifier, as a percentage of the rectifier rated current. Used by APR-
3G, NPR, R2948, and R5848 series. 

 

OVSD Set Point (Rectifier) 
Rectifier Over Voltage Shut Down set point. Not used by all rectifier types. 

 For 3G rectifiers the recommended value is 1.6V above Maximum System Voltage. 
 

Passthrough Communications 
A CellSure Battery Controller (CBC) can be connected to an SM45, SM50 or SM65 supervisory 
module and all communications to the CBC are through the supervisory module's external 
communications connection (RS232, modem or Ethernet) . 
See also: Serial Server on page 111 

 

Password (HTTP) 
The password for this user. 

 

Phone Number (SMS Notifications) 
The phone number for SMS notifications. 
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Physical Mounting 
The orientation of the LCD. 

 

Poll By Callback 
(Applies only when a modem is selected in Connect Using.) 
Select this option if you want the selected modem to use a poll-by-callback method when 
establishing connection with the remote modem at the dc power system.  

 

Poll Interval (SNTP) 
Polling interval in seconds. 

 

Port (SNMP Receiver) 
SNMP notifications of events are sent to this UDP port. 

 

PowerManagerII 
PowerManagerII is a software tool for remote management of multiple Eaton dc power 
systems. 

 

Primary Address (SNTP) 
IP address of Primary SNTP server. 

 

Pull In Value (LVD) 
The voltage which the IOB applies to initially connect the LVD. 

 

RCP 
Control protocol used by the supervisory modules to communicated with rectifiers, SiteSure 
modules and other dc power system devices. 

 

Read (HTTP) 
When set true the user has access to database items that require Read Only user access level. 

 

Recharge Percentage (Fast Charge) 
The ratio of ampere-hours recharged to the ampere-hours discharged. Fast Charge stops when 
the recharge Ah recharged x Fast Charge Recharge Percentage equals the Ah discharged, or 
after Maximum Duration. 

 

Recognition Period (LVD1) 
The time the bus voltage must be below the LVD1 Disconnect Voltage before disconnection, or 
above the LVD1 Reconnect Voltage before reconnection. 

 

Recognition Period (LVD2) 
The time the bus voltage must be below the LVD2 Disconnect Voltage before disconnection, or 
above the LVD2 Reconnect Voltage before reconnection. 

 

Reconnect Voltage (LVD1) 
LVD1 reconnects when the bus voltage has been above this value for the LVD1 Recognition 
Period and LVD2 is disabled, or has already reconnected, or is in slave mode. 
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Reconnect Voltage (LVD2) 
LVD2 reconnects when the bus voltage has been above this value for the LVD2 Recognition 
Period. This parameter is ignored if Enable LVD2 Slave Mode is Enabled. 

 

Rect Cycle High Threshold (Load Based Rectifier Shutdown) 
If the load power is above this percentage of total system power then any shutdown rectifiers 
will be restarted. 

 

Rect Cycle Interval (Load Based Rectifier Shutdown) 
The time interval in minutes that rectifiers are cycled when the LBRS process is active. 

 

Rect Cycle Low Threshold (Load Based Rectifier Shutdown) 
Rectifiers will only be shut down by the LBRS process if the load power is below this percentage 
of total system power. 

 

Rectifier Current 
The total current output by all rectifiers derived from the sum of all current inputs mapped as 
rectifier shunts. If there are no rectifier shunts but there are battery and load shunts, the rectifier 
current is calculated as Battery Current + Load Current. Otherwise rectifier current is 
determined as the sum of all reported rectifier output currents. 

 

Rectifier Current Limit 
The output current limit of the rectifier. If set to zero then the output current is maximum. Used 
by APR-3G, APR, APU, NPR, R2948 and R5848 series. 

 

Rectifier Shutdown 
Allows remote rectifier shutdown/restart. 

 

Reference Temp (Temperature Compensation) 
The temperature where no voltage adjustment is applied. Use the value specified by the battery 
manufacturer. 

 

Remaining Time (Battery Test) 
The time to the end of the currently active Battery Test. 

 

Remaining Time (Equalize) 
The time until the current Equalize cycle will stop. 

 

Remote Control State (Digital Outputs) 
Allows remote control of the digital output. 

 

Reset Battery Test Failed Alarm 
This command attempts to reset Battery Test Failed alarm. 

 

Reset Rectifier Comms Lost Alarm 
This command attempts to reset Rectifier Comms Lost alarm and Multiple Rect Comms Lost 
alarm. 

 

Restart All Rectifiers 
This command sets all Shutdown Rectifier elements to false. 
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Restore (HTTP) 
When set true the user is allowed to upload configuration or snapshot. 

 

Retry Wait 
(Applies only to modem connections.)  
The time Connection Manager will wait before making a re-dial attempt to a Device via a 
modem.  

 The Number of Dial Attempts value determines how many times Connection Manager 
will re-dial the same Supervisory Module or CellSure Battery Controller. 

 

Run Up Date 
The date the connected device was run up in the factory. The format of the date is dd/mm/yy. 
This item is not reset by the Reset System Configuration command. 

 

RXP 
Advanced control protocol used by the SC100 and SC200 system controllers to communicated 
with rectifiers, I/O boards and other dc power system devices. 

 

S3P 
Proprietary serial communications protocol used to communicate with a connected Device. 

 

S3P Address 
The S3P slave address. 

 

S3P Connect Sequence Retries 
(Applies only to modem connections with the S3P protocol.)  
After a carrier has been detected, the modem may still require some time before the connect 
response comes through. The Number of Connect Retries should be set to at least 5. There is 
little harm in setting it too high, but setting it too low can reduce your communications 
reliability. 

 

S3P Number of Retries 
The number of consecutive, unsuccessful connection attempts to any Device, after which 
Connection Manager will display a Failed status for that connection (if the Overriding Timeout 
has not expired first).  
Accept the default  value of 1 if the connections are very reliable. Otherwise, select a higher 
Number of Retries. 

 

S3P Overriding Timeout 
The maximum time Connection Manager will spend trying to connect to a Device before 
displaying a Failed status for that connection (if the Number of Retries have not occurred first). 
S3P Multidrop Networks:  
Accept the default value of 60s. 
Modem connections:  
Because modem communications are slower than other types of communications, the 
overriding timeout should be more than for direct connections. A value of 120s is 
recommended. 
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S3P Timeout 
The time Connection Manager will wait for a response from a Device before displaying a Failed 
status for that connection. 
S3P Multidrop Networks:  
You may need to adjust this Timeout value if large network delays are common. Otherwise, use 
the default of 1000ms.  
Modem connections:  
Because of the buffering that occurs, this needs to be more than for direct connections. A 
minimum value of 2000ms is recommended. 

 

Scripting Timeout 
(Applies only to modem connections with callback security.)  
The maximum time Connection Manager will wait for an expected prompt when running a 
Modem Logon script, before giving up and reporting a Script Failed communications error. 

 

Serial Number 
The Product Serial Number. This item is not reset by the Reset System Configuration command. 

 

Serial Number (I/O Board Mapping) 
This provides a mapping from I/O board numbers as used by the analog input configuration to 
I/O board serial numbers. 

 

Serial Number (Rectifier) 
Rectifier serial number. 

 

Serial Number (RXP Devices) 
The serial number of this device. 

 

Serial S3P Passthrough Port (Ethernet) 
Server port number for Ethernet S3P connections. 

 

Serial Server 
The SC200's Serial Server function makes the SC200's RS232 port available to any software via 
Ethernet. For example, use Serial Server to connect DCTools to a CellSure Battery Controller 
(CBC) connected to the SC200. 

 

Severity (Alarm States) 
Specifies the severity of the alarm. 

 

Severity (Digital Inputs) 
Alarm severity indicator 

 

Site Address 
The street address of the site. 

 

Site Name 
The site designation or code. 
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Site Notes 
Notes made by the installation or maintenance personnel. 

 

SiteManager 
SiteManager is a feature of PowerManagerII that enable specially configured inputs and 
outputs to be organized and displayed separately. 

 

Slope (Temperature Compensation) 
Bus voltage adjustment rate. Use the value specified by the battery manufacturer. 

 

Smart Alarm 
Smart Alarms are a software simulation of logic gates to allow the logical combination of other 
alarms, time schedules and/or system values for customized alarm and control systems. 

 

SNMP 
Simple Network Management Protocol. A protocol used to broadcast database status 
information to a network management system such as HP OpenView®. 

 

SNMP Access 
Determines how SNMP access is allowed. 

 

SNMP Number of Retries 
The number of consecutive unsuccessful connection attempts to a Device, after which 
Connection Manager will displaying a Failed status for that connection.  
Ethernet:  
Adjust this Timeout value if large network delays are common. Otherwise, use the default of 
20s.  
Modem connections:  
Because of the buffering that occurs, this needs to be more than for direct connections. A 
minimum value of 60s is recommended. 

 

SNMP Read Community 
Community that can get items. 

 

SNMP Timeout 
The maximum time Connection Manager will spend trying to connect to a Device before 
displaying a Failed status for that connection.  
Ethernet:  
Adjust this Timeout value if large network delays are common. Otherwise, use the default of 
20s.  
Modem connections:  
Because of the buffering that occurs, this needs to be more than for direct connections. A 
minimum value of 60s is recommended. 

 

SNMP Write Community 
Community that can set items. 
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SNTP 
Simple Network Time Protocol. An Internet protocol that allows time synchronization with 
SNTP time servers. 

 

Software Version 
Application software version. This is the software version of the main controller application. 

 

Software Version (RXP Devices) 
Software Version of the RXP device. 

 

Startup Delay (Rectifier) 
The delay from ac turn-on before the rectifier output turns on. 

 

State (Alarm States) 
The state of this alarm. 

 

State (Digital Outputs) 
The state of this digital output. Active digital outputs may be energized or de-energized 
depending on their configuration. 

 

State (RXP Devices) 
Registration state of the slave with RXP Slave Serial Number serial number. 

 

Status (Analog Inputs) 
Enable/disable this analog input channel. 

 

Status (Digital Inputs) 
Enable/disable this digital input channel. 

 

Status (Digital Outputs) 
Enable or disable this digital output. If disabled, the digital output is not driven. 

 

Status (Rectifier) 
The status reported by this rectifier. 

 

Subnet Mask (Ethernet) 
Identifies which fragment of the IP address is the sub-network identity. This value and the IP 
Address must be set correctly to communicate using Ethernet. Consult your network 
administrator. 

 

Sum of Reported Rectifier Currents 
The sum of all Rectifier Reported Current values. In systems with only one shunt, this value is 
used as the Rectifier Current. 

 

System Location 
Usually the location of the dc power system within the site. 

 

System Manufacturer 
The manufacturer of the dc power system. 
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System Object ID 
Used to form the return value for the SNMP MIB-2 sysObjectId. These numbers start with a 
specific enterprise ID (i.e. 1918 for Eaton) and are preceded by 1.3.6.1.4.1 to form an object ID for 
the system type. 

 

System Overload Recognition Period 
The System Overload alarm activates if the load is above the System Overload Threshold 
continuously for this time. It is normally set to several hours so that the alarm does not operate 
during a normal battery recharge. 

 

System Overload Threshold 
The System Overload alarm activates if the load is above this threshold continuously for the 
System Overload Recognition Period. Measured as a percentage of total rectifier capacity. 

 

System Overload Type 
If the System Overload Type is total capacity, then the alarm will trigger when the load is above 
the System Overload Threshold for the System Overload Recognition Period. If the System 
Overload Type is redundancy, then the alarm will trigger when the load is above the total 
current capacity of the system minus the current capacity of the largest rectifier for the System 
Overload Recognition Period. 

 

System Power 
The output power of the system as a percentage of the total nominal power of the registered 
rectifiers. 

 

System Serial Number 
The dc power system serial number assigned by the manufacturer. 

 

System Type 
The dc power system model number assigned by the manufacturer. 

 

Target Voltage 
The voltage maintained by AVC. AVC will set the Base Voltage to attempt to maintain the Bus 
Voltage to this value. 

 

Temperature Compensation 
When enabled, the battery charge voltage is automatically adjusted based on temperature. This 
is recommended by battery manufacturers to optimize battery life. 

 

Termination Voltage (Battery Test) 
If the bus voltages drops below this value during a Battery Test, then the test fails. 

 

Test State (Digital Outputs) 
Allows control of the digital output for test purposes. This helps to confirm wiring installation. 

 

Trap Community (SNMP Receiver) 
Community to use for traps sent to the receiver. 
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Trap Format 
Select Eaton for multiple trap numbers, or X.733 for a single trap number as per ITU X.733. 

 

Trap Repeat 
If enabled, alarm activation traps will be repeated according to Trap Repeat Rate. 

 

Trap Repeat Rate 
How often to send a trap to trap receivers if Enable Trap Repeat is Enabled or the trap receiver's 
Trap Receiver Mode is Acknowledged Summary Trap. 

 

Trap Version 
Indicates whether SNMP v1, SNMP v2 or SNMP v3 trap will be sent. 

 

Type (RXP Devices) 
What type of component (IOB, rectifier, and so on) this device is. 

 

UDP Port (SNTP) 
SNTP client destination port. 

 

UI 
User Interface. The keypad and LCD on the front of the Device. 

 

UI Access 
Controls keypad access to change configuration items, and start or stop processes. This 
provides protection against unauthorized or accidental modifications of configuration settings. 

 

UI Access PIN 
If UI Access is set to PIN Protected then this value must be entered before any changes to 
configuration items or control actions can be made. 

 

Units (Analog Inputs) 
Units of this analog input (after scaling). 

 

Upgrade Firmware (HTTP) 
When set true the user is allowed to upgrade firmware (including de-installing optional 
modules). 

 

Upper Limit (Temperature Compensation) 
No additional voltage adjustment is made above this temperature. 

 

User Name (HTTP) 
The full name of the user. This is for reference only and is not used in the login process. 

 

Value (Analog Inputs) 
Analog input value. 
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Value (Digital Inputs) 

Voltage (Equalize) 
The bus voltage maintained during an Equalize cycle. The bus voltage is further adjusted by 
Temperature Compensation. 

 

Voltage (Fast Charge) 
The bus voltage maintained during Fast Charge (use the value recommended by the battery 
manufacturer). Adjustments for Temperature Compensation and Battery Current Limit also 
apply. 

 

Voltage (Rectifier) 
The output voltage measured by this rectifier. This is measured by the rectifier and reported via 
the RXP bus. 

 

Voltage Threshold (Fast Charge) 
If the bus voltage drops below this value, then Fast Charge occurs when the ac supply is 
restored. Fast charge can also be triggered based on the Fast Charge Ampere Hour Threshold. 

 

Write (HTTP) 
When set true the user has access to database items that require Write user access level. 

 

Write Access Password 
If set, requires a password to be used before write access is granted. This password may be used 
to control remote configuration change or control actions. Note that the password is sent 
unencrypted. 
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Worldwide Support 

For product information and a complete listing of worldwide sales offices, visit Eaton's website 
at: www.eaton.com/telecompower or email: DCinfo@eaton.com 
For technical support contact either your local Eaton dc product representative, the closest 
office from the following list, telephone (+64) 3 343-7448, or email 
CustomerServiceNZ@eaton.com 
 

 
 
 

Australia:  1300 877 359 

Canada:  1-800-461-9166 

Central America:  +52 55 9000 5252 

China:  +86-571-8848-0166 

Europe / Middle East / Africa:  +44-1243-810-500 

Hong Kong / Korea / Japan:  +852-2745-6682 

India:  +91-11-4223-2325 

New Zealand 0800 DC Power (0800 327-693) 

Singapore / South East Asia:  +65 6825 1668 

South America:  +54-11-4124-4000 

South Pacific:  +64-3-343-7448 

Taiwan:  +886-2-6600-6688 or free call 0800-038-168 

United States of America (Toll Free):  1-800-843-9433 - option 2 - option 6 
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A 
AC Input Voltage • 40, 50 

AC Metering • 45 
Low AC Threshold • 59 

Accessibility Options • 23 
Active Voltage Control • 52, 53, 87 
Alarms • 30, 40, 47 

Smart Alarms • 48 
Analog Inputs • 50 
Apply Changes • 25, 27, 29 
Audible Alarm Indication • 47 

B 
Backup • 25, 30, 32 

Backup File •  See DCT File Type 
Base Voltage • 52, 87 
Battery 

Battery Capacity • 59 
Battery Characterization • 56 
Battery Charge State • 59 
Battery Current • 40, 50, 52, 61, 62, 87 
Battery Current Limit • 52, 55, 87, 88 
Battery Temperature • 40, 47, 50, 52, 59, 61, 62, 

87 
Battery Test • 52, 55, 89 
Cells Per String • 59 
CellSure Battery Controller (CBC) • ii, 45, 64 
Mid-point Monitoring • 59, 88 
String Fail Alarm • 88 
Time Remaining • 89 

Bus Voltage • 50, 52, 61, 62, 87 

C 
Cells Per String • 59 
CellSure Battery Controller (CBC) • ii, 45, 64 

CBC Alarms • 77, 78 
CBC Communications • 15, 72, 97 

Serial Server (SC200) • 16, 42 
CBC Configuration • 70 
Summary View • 64 

Celsius (temperatures) • 23 

Closing DCTools • 2, 3, 19 
Communications • 6, 9, 13, 42, 97 

CBC Communications • 15, 72, 97 
CSP • 42 
Ethernet Communications • 14, 16, 42 
Global Communications Options • 7, 10 
HTTP/HTTPS (web) Communications • 42 
Modbus (SC200 only) • 42 
Multidrop (RS485) Communications • 14, 16 
Passthrough Communications • 15 
Serial (S3P) Communications • 10, 13, 14, 15, 16, 

42 
Serial Server (SC200) • 16, 42 
Troubleshooting • 18 
USB Communications • 2 
Web Communications • 42 

Connection Manager • 2, 6, 7, 20 
Adding a New Connection • 9, 12 
Closing Connection Manager • 20 
Connecting • 6, 9, 17 
Connection List • 6, 9, 11 
Connection Properties • 9, 13 
Deleting a Connection • 9, 20 
Failed -  Connection Error • 9, 17, 18 
Interface Version • 17, 41 
Renaming a Connection • 12 
Target Failed to Respond Error Message • 18 
Terminating a Connection • 3, 6, 19 
Title Bar • 24 

Copying and Pasting Data • 25, 30, 33 
CSP • 42 
CSV File Type • 30 
Current Share • 89 

D 
Data Log • 61 

Log Configuration • 61 
Data Window • 22, 24, 25 

Copying and Pasting Data • 25, 30, 33 
Editing Data • 29 
Export • 30 

DC Output 
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Load Current • 40, 50, 61, 62 
Output Voltage • 40, 50, 52 
Rectifier Current • 40, 50, 61, 62 

DC Power Systems •  See Related Information 
DCC File Type • 25, 32, 41 
DCS File Type • 25 
DCT File Type • 25, 30 
DCTools 

Closing DCTools • 2, 3, 19 
Starting DCTools • 2 
System Tray Icon • 2 

DCTools Log • 22, 25, 30, 34 
Device • ii, 98 
Digital Inputs • 50 
Digital Outputs • 51 

E 
Editing Data • 29 
Engine Run • 55, 88 
Equalize • 52, 54, 87, 90 
Ethernet Communications • 14, 16, 42 
Event Log • 60 

Log Configuration • 61 
Export • 30 
External I/O • 45 

F 
Fahrenheit (temperatures) • 23 
Failed -  Connection Error • 9, 17, 18 
Fast Charge • 52, 54, 87, 90 
Float Voltage • 52, 87 
Font Size • 23, 25 
Front Panel Configuration • 42 
Full Screen View • 23, 25 

G 
Generator Start • 90 
Global Communications Options • 7, 10 

H 
Help • 8, 25, 30 
Hold Changes • 25, 27 
HTTP/HTTPS (web) Communications • 42 

I 
Identify Device • 44 
Identity • 41 
Information Bar • 25, 27 
Input/Output (I/O) 

Analog Inputs • 50 
Digital Inputs • 50 
Digital Outputs • 51 
External I/O • 45 
I/O Boards • 43 

Interface Version • 17, 41 
IRC File Type • 25, 32, 41 

K 
Keyboard Shortcuts • 31 

L 
Language • 8, 23 
Load Current • 40, 50, 61, 62 
Load Power • 50 
Load-based Rectifier Shutdown • 59, 92 
Log 

Data Log • 61 
DCTools Log • 22, 25, 30, 34 
Event Log • 60 
Log Configuration • 61 
Monitor Log • 60 
PC Log • 62, 85 

Logon • 104, 106 
Low Voltage Disconnect (LVD) • 57, 93 

M 
Maximum Voltage • 52, 87 
Menu • 6, 25 
Mid-point Monitoring • 59, 88 
Minimum Voltage • 52, 87 
Modbus (SC200 only) • 42 
Modem Communications • 10, 42, 106 
Monitor Log • 60 
Multidrop (RS485) Communications • 14, 16 

N 
N/A • 52 
Navigation • 6, 25, 27, 31 
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O 
O/R • 52 
Online/Offline Modes • 23, 24, 30 
Operating Voltage • 52, 87 
Output Power • 50 
Output Voltage • 40, 50, 52 

Ramp Up Slope • 59 
Over Voltage Shutdown (OVSD) • 59 

P 
Passthrough Communications • 15 
Password • 22, 32 
Paste •  See Copying and Pasting Data 
PC Log • 62, 85 
PC specifications • 2 
Pending Changes • 24, 27, 29 
Problems •  See Troubleshooting 

Technical Assistance • 117 

R 
Ramp Up Slope • 59 
Rectifiers • 59 

Current Share • 89 
Low AC Threshold • 59 
Output Voltage • 40, 50, 52 
Ramp Up Slope • 59 
Rectifier Current • 40, 50, 61, 62 
Rectifier Current Limit • 59 
Rectifier Shutdown • 59 
Registration • 43 
Reset Rectifier Comms Lost • 59 
Restart All Rectifiers • 59 
Startup Delay • 59 

Related Information • ii 
Relays •  See Digital Outputs 
Restart All Rectifiers • 59 
Right-Click Menu • 8, 30 
RS232 •  See Serial (S3P) Communications 
RS485 •  See Multidrop (RS485) Communications 
RXP • 43 

Identify Device • 44 
Standby Mode • 44 

S 
Serial (S3P) Communications • 10, 13, 14, 15, 16, 

42 
Serial Server (SC200) • 16, 42 
Shutdown 

Load-based Rectifier Shutdown • 59, 92 
Over Voltage Shutdown (OVSD) • 59 
Rectifier Shutdown • 59 
Restart All Rectifiers • 59 

SiteSure Modules • ii,  See External I/O 
SiteSure-3G • ii,  See I/O Boards 
Smart Alarms • 48 
SNMP • 10, 42,  See Ethernet Communications 
SNTP • 44 
Standby Mode • 44 
Start Equalize • 90 
Starting DCTools • 2 
Startup Delay • 59 
Status Bar • 25, 30 
String Fail Alarm • 88 
Supervisory Modules •  See Related Information 
Synchronize Time • 44 
System Controllers •  See Related Information 
System Power • 50 
System States • 50 
System Summary • 40 
System Tray Icon • 2 
System Values • 50 

T 
Table Expansion • 28 
Target Failed to Respond Error Message • 18 
Target Voltage • 52, 87 
TCP/IP •  See Ethernet Communications 
Technical Assistance • 117 
Temperature (units) • 23 
Temperature Compensation • 52, 53, 87, 94 
Time and Date • 44 

SNTP • 44 
Time Remaining • 89 
Title Bar • 24 
Toolbar • 6, 9, 25, 27, 31 
Tree View • 24, 27, 31 
Troubleshooting • 18 

Technical Assistance • 117 
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U 
USB Communications • 2 

V 
Voltage Control • 40, 52 

W 
Web Communications • 42 
Welcome Screen • 2 
Windows (compatible versions) • 2 
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